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1. RESUMEN 

ImageJ es un poderoso programa de análisis de imágenes de libre acceso, 

ampliamente utilizado en el ámbito científico, especialmente en el mundo biológico y 

de los materiales. En este contexto, se evaluará la aplicabilidad y utilidad del programa 

en las ciencias de los alimentos. Además, se desarrolló un instructivo de uso de 

ImageJ, que permita a los estudiantes de la carrera de ingeniería en alimentos poseer 

una guía de acceso básica y práctica para su utilización. 

Para la elaboración del manual, se evaluaron las funciones más destacadas que 

presenta el programa. Por medio de la captura de imágenes controladas y no 

controladas, se evaluó el comportamiento del programa para la medición de color en 

muestras de frutillas, largo en muestras de tomates Cherries y el recuento de unidades 

(manual y predictivas) del programa en diversos tamaños de semillas. Para validar la 

reproducibilidad del programa, se utilizaron las imágenes de dos publicaciones 

científicas que utilizan ImageJ para el recuento y/o predicción de unidades (UFC y 

tamaño de emulsión) y se realizaron los mismos recuentos para comparar los 

resultados. 

Una vez elaborado el manual, se realizó su validación cualitativa y cuantitativa por 

medio de una encuesta. En esta, se solicitó realizar diferentes análisis de imágenes 

utilizando ImageJ y el instructivo. Paralelamente se demostró la aplicación del 

programa en un análisis de casos en frutos chilenos, piñón (fruto del árbol nacional y 

protegido Araucaria) y el arándano como ejemplos de frutos homogéneos, 

circunferenciales y su opuesto. 

El estado del conocimiento demostró la existencia de 23400 publicaciones, de las 

cuales el 96% corresponden a artículos de investigación científica, siendo Estados 

Unidos el mayor generador de conocimientos a nivel mundial. En el análisis de 

imágenes, las imágenes estandarizadas y no estandarizadas en medición de color y 

largo, demuestra la necesidad de control sobre la captura de imágenes para el correcto 

desempeño del programa. En el recuento manual y de predicción de unidades sobre 

las semillas, tanto en las imágenes estandarizadas como no estandarizadas, se 

presentaron similitudes entre las imágenes. Los análisis realizados a partir de 
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publicaciones científicas no demostraron diferencias significativas entre los valores de 

respuesta original y los calculados.  

Además, la validación del instructivo mostró que existían diferencias significativas en 

los valores obtenidos del análisis de imágenes realizado por los participantes de la 

encuesta, estas pudieron ser atribuibles a las mejoras necesarias el instructivo y que 

fueron señaladas por la encuesta, las cuales correcciones fueron implementadas tras 

la validación. El análisis de casos de frutos chilenos se desarrolló sin dificultades, 

obteniendo las características morfométricas, de color y textura de los alimentos 

mediante las herramientas del programa, demostrando su aplicabilidad en este ámbito 

científico para caracterizar de manera efectiva estas propiedades.  

En conclusión, se destaca el buen desempeño de ImageJ, su comprensión, 

manipulación y su posible uso en las ciencias y tecnologías de los alimentos para el 

desarrollo de nuevas investigaciones. 
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ABSTRACT 

ImageJ is a powerful open-source image analysis program widely used in the scientific 

community, especially in the biological and materials sciences. In this context, the 

applicability and usefulness of the program in food sciences will be evaluated. In 

addition, a user´s guide for ImageJ was developed to provide food engineering students 

with a basic and practical access guide. 

For the preparation of the manual, the program's most important functions were 

evaluated. Through the capture of controlled and uncontrolled images, the program's 

performance in color measurement in strawberry samples, length in cherry tomato 

samples, and the counting of units (manual and predictive) in various seed sizes was 

assessed. To validate the program's reproducibility, images from two scientific 

publications using ImageJ for unit counting and/or prediction (CFU and emulsion size) 

were used, and the same counts were performed to compare the results. 

Once the manual was prepared, its qualitative and quantitative validation was carried 

out through a survey. In this, image analyses were conducted using ImageJ and the 

guide. Concurrently, the application of the program was demonstrated in a case study 

of Chilean fruits, including piñon (the fruit of the national and protected Araucaria tree) 

and blueberry, as examples of homogeneous, circumferential fruits and their opposite. 

The state of knowledge demonstrated the existence of 23,400 publications, of which 

96% are scientific research articles, with the United States being the largest generator 

of knowledge worldwide. In the image analysis, standardized and non-standardized 

images for color and length measurement highlighted the need for controlled image 

capture for the program's proper performance. In the manual and predictive counting 

of units on seeds, similarities were found between standardized and non-standardized 

images. Analyses based on scientific publications did not show significant differences 

between the original response values and the calculated ones. 

Furthermore, the validation of the manual revealed significant differences in the values 

obtained from the image analysis conducted by survey participants. These differences 

could be attributed to necessary improvements in the manual, as identified by the 

survey, which were subsequently implemented post-validation. The analysis of Chilean 
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fruit cases proceeded smoothly, extracting morphometric, color, and texture 

characteristics of the foods using program tools, demonstrating its applicability in this 

scientific field for effectively characterizing these properties. 

In conclusion, the commendable performance of ImageJ in comprehending, 

manipulating, and its potential use in food sciences and technologies for new research. 
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2. INTRODUCCIÓN 

En la última década, los avances tecnológicos han transformado radicalmente el 

panorama científico, ofreciendo nuevas oportunidades de investigación en diversos 

campos, incluyendo las ciencias de los alimentos(Andrialovanirina et al., 2020; 

Siegmann et al., 2004; Sunoj et al., 2018). Este cambio se refleja en la capacidad para 

realizar análisis detallados de calidad, morfología y reconocimiento de color en 

productos alimenticios. En este contexto, el análisis y procesamiento de imágenes se 

ha vuelto esencial para extraer información de manera precisa a partir de imágenes 

digitales. La principal característica que favorece el análisis de imagen sobre el 

tradicional es la capacidad de procesamiento del computador el cual permite analizar 

cientos de imágenes por hora, lo cual es un proceso lento de realizar por un método 

tradicional.(Andrialovanirina et al., 2020) 

Este proyecto se centra en la aplicación de la herramienta ImageJ, un software de 

análisis de imágenes gratuito, quien, con su diseño simple de fácil comprensión, 

mejora continua debido a colaboración constante de los usuarios, destaca entre otros 

programas similares. La elección de ImageJ se justifica por su formato en Java 

compatible con cualquier sistema operativo, bajo requerimiento computacional para 

uso y amplia aplicabilidad, la cual a pesar de ser más de 25 años de creación no solo 

persiste en su uso y es ampliamente aplicado en la generación de 

conocimientos(Pérez & Pascau, 2013; Schneider et al., 2012) 

Con el objetivo de proporcionar un instructivo funcional del uso de ImageJ, se 

evaluarán las capacidades del software como herramienta aplicada en las ciencias de 

los alimentos. Para ello, se realizará una revisión de información bibliográfica, se 

llevarán a cabo ejemplos de su aplicación en entornos controlados y no controlados, y 

se evaluará la reproducibilidad de las mediciones para demostrar la eficacia de 

ImageJ. Finalmente, se validará el instructivo por una encuesta y se realizará un 

análisis de características físicas de frutos chilenos homogéneos y no homogéneos, 

demostrando la posible aplicación del software como una herramienta educacional y 

de investigación en el análisis de imágenes en las ciencias y tecnologías de los 

alimentos. 
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3. MARCO TEÓRICO 

3.1. ANÁLISIS DE IMÁGENES DIGITALES 

El análisis de imágenes trata de la conversión de una imagen en datos. En algunos 

casos se trata de limpiar la imagen con la finalidad de destacar algún elemento de 

interés dentro de ella, en otros se trata de ordenar y procesar una imagen esta es 

convertida a una escala integrada como seria cambiar una de escala de color a 8-bits 

para finalmente medir, cuantificar o procesar los datos obtenidos de la imagen original. 

Este análisis cuenta con cinco pasos para su realización: primero captura de imagen, 

segundo preprocesamiento (que deseo hacer con la imagen), tercera segmentación 

de la imagen (separar la imagen entre el fondo, el objeto de interés y el ruido), cuarto 

la extracción de características y finalmente la clasificación (Chanona-Pérez et al., 

2008) 

Con la modernización y el hecho que todos poseen un computador en su escritorio, la 

adquisición de imágenes también se ha vuelto mucho más accesible, debido a que hoy 

en día se pueden tomar fotografías por un celular, cámara digital o por un 

escáner.(Burger & Burge, 2016). Estas imágenes en su formato digital pueden ser 

analizadas como se mencionó anteriormente, si bien existen softwares como Adobe 

Photoshop® que es un programa de análisis y procesamiento de imágenes altamente 

reconocido que ofrece una interfase de fácil comprensión y una amplia variedad de 

herramientas para modificar las imágenes de manera interactiva (Burger & Burge, 

2016). La dificultad que presenta el programa Photoshop es que no es una aplicación 

gratuita ya que consta de una suscripción mensual pagada, su principal uso es la 

edición de imágenes, soportando los espacios de color RGB, CMYK y CIELAB y no 

posee herramientas que permitan cuantificar o predecir sucesos como sí es posible el 

programa ImageJ que es un programa de libre acceso y altamente utilizado en el 

ámbito científico.(Adobe, 2022). 
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3.1.1. Adquisición de imágenes 

Cada día se capturan miles de imágenes, ya sean fotografías de personas o paisajes, 

un documento escaneado, enviando documentos digitales, capturas de pantalla o en 

el ámbito médico, la toma de rayos x a los pacientes o la realización de los ultrasonidos. 

Pero sin importar el uso o el origen de la imagen, todas concuerdan en ser una matriz 

rectangular y ordenada de pixeles., los cuales son su unidad estructural(Burger & 

Burge, 2016a) 

Una vez capturada la imagen, esta puede presentar diversas características como son 

la calidad de la imagen o resolución, dicho en otras palabras, cuantos pixeles existen 

en una superficie. A mayor cantidad de pixeles, mejor resolución, color más nítido y 

mayor tamaño ha de tener. Este tamaño no sólo se limita a la resolución de la imagen, 

sino que al espacio que utiliza en una memoria de archivo gráfico, entre los cuales 

destacan el JPEG y el PNG como los formatos más reconocidos. (Burger & Burge, 

2016b). 

 

Así mismo, la iluminación, contraste y ubicación de la imagen al ser capturada 

generará un cambio de color y calidad de la imagen, considerando que una importante 

característica de las imágenes de alimentos es el reconocimiento del alimento y el 

atractivo de este. En un ambiente controlado o estandarizado da como resultado 

 

Fuente:(Alonso, 2020) 

Figura 1. Ilustración de una rosa con zoom a sus pixeles. 
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imágenes de alta calidad, y permite a los investigados alcanzar y seguir los objetivos 

para generar estudios adicionales con imágenes de las mismas resolución y calidad. 

(Charbonnier et al., 2015) La figura 2 demuestra las diferencias entre una imagen 

controlada(estandarizada) y no controlada. 

(a)  

(b)  (c)  

Fuente :(Charbonnier et al., 2015) 

Figura 2. Ejemplo de fotografías de alimentos  

(a)No controlada, (b)Imagen controlada capturada en Países bajos, (c)Imagen 

controlada capturada en Grecia 

 

3.1.2. Metodologías de captura de imágenes 

Como ya se ha señalado existen diversas formas de capturar una imagen las cuales 

tendrán diferentes características dependiendo de la temperatura que existe y el uso 

de la imagen o del medio utilizado para su captura. A continuación, se nombrarán los 
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medios más comúnmente utilizados para la captura de imágenes digitales y ejemplos 

de sus usos en los alimentos. 

 

3.1.2.1. Escáner 

Los escáneres son maquinas relativamente económicas que permiten digitalizar de 

manera automática el objeto digitalizado o imprimirlo de manera automática. Los 

escáneres planos de escritorio (figura 3) utilizan una luz reflejada que viene desde la 

parte inferior del escáner, para realizar la captura de la imagen que se encuentra sobre 

un vidrio, dando como resultado una imagen bidimensional del objeto. Los beneficios 

que presente este equipo son una captura de alta resolución y buena definición de 

color a bajo costo, en un corto tiempo, mientras que su principal limitación es el 

impedimento de realizar imágenes de transparencias y negativos y la necesidad de 

limpiar el equipo después de colocar una muestra que deje suciedad en el vidrio, ya 

que afectaría a posteriores capturas(Russ, 2005). Idealmente se busca que las 

muestras u objetos a analizar sean planos por la profundidad del escáner, el cual posee 

aproximadamente 1cm de espesor, y en caso de muestras alimentarias se recomienda 

no utilizar alimentos congelados debido a la condensación. 

(a)  (b)  

Fuente:(Russ, 2005) 

Figura 3. Escáner plano. 

(a)Muestra de carne sobre el escáner, (b)Imagen de las muestras de carne 

obtenidas. 
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Los escáneres poseen sensores que permiten identificar la luz roja, verde y azul por 

separado, lo que permite una muestra altamente digitalizada de buena resolución y 

transmitida directamente a un computador en formato 8bit en RGB(Russ, 2005).Si bien 

la utilización de un escáner es más incómoda que una cámara digital, debido al 

contacto directo con la muestra genera una imagen con menor interferencia que una 

imagen digital y siendo una copia fiel de la original. 

 

3.1.2.2. Cámaras digitales 

Las cámaras digitales han tomado gran parte del mercado de imágenes científicas. 

Inicialmente caras, las cámaras digitales han ido disminuyendo su precio según han 

ido mejorando sus características técnicas, siendo aún su mayor problema el 

almacenamiento de las imágenes, ya que imágenes de gran resolución utilizan más 

espacio de almacenamiento.(Russ, 2005) Las cámaras digitales al igual que los 

escáneres poseen una alta resolución espacial y una gran calidad con bajo ruido o 

interferencia de imagen.  

Uno de los mayores impedimentos de las cámaras digitales es cubrir rangos diferentes 

de tamaños, en estructuras muy pequeñas no saldrían acordes a su tamaño, debido a 

que los pixeles necesarios para retratarlos no permitirían una buena resolución, como 

se observa en a la figura 4 donde a partir de una emulsión de mayonesa se nota 

diferencia de definición de la imagen según su calidad en la figura.4(a) se observa 

cada parte de la emulsión, observando las gotas de aceite/agua y siendo visible la 

capa que bordea cada una de las estructuras, mientras que en la figura 4(b) no es 

posible identificar la imagen original o alguna ninguna de sus partes. Debido a lo 

anterior, se busca poseer imágenes de alta resolución (gran número de pixeles, 

generalmente desde 1200x900) para obtener un mayor detalle o definición en 

imágenes pequeñas o microscópicas al poseer marco lentes u objetivos tipo 

microscopios.(Russ, 2005)  
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(a)  (b)  

Fuente:(Russ, 2005) 

Figura 4. Imagen de una emulsión de una mayonesa.  

(a)Imagen de alta resolución, (b)Efecto del decrecimiento (en 3 megapíxeles) en la 

resolución. 

 

En la actualidad, la revolución tecnológica y su integración han modificado desde los 

teléfonos fijos a los móviles hasta ser llamados inteligentes, que ya cuentan con 

cámaras digitales y se encuentran en una constante evolución en busca de más 

pixeles, menor tamaño, menor costo y mayor memoria, permitiendo tomar fotografías 

de mayor calidad y validez científica, permitiendo desde el 2010 tener cámaras de 

mejor resolución integrados en cada uno de ellos, considerando desde los 12 

megapíxeles ya un celular con una alta gama de captura de imágenes(Padilla-Sierra 

et al., 2022). 

 

3.1.2.3. Microscopios electrónicos 

Existen distintos tipos de microscopios electrónicos, entre ellos se incluyen, el 

microscopio electrónico de barrido (SEM), microscopio confocal de rayos láser y el 

microscopio de fuerzas atómicas (AFM) los cuales utilizan diferentes principios físicos 

para la obtención de imágenes. El microscopio confocal utiliza espejos para desviar el 

haz de luz laser que entra en contacto con la muestra, mientras el SEM usa los campos 

magnéticos para realizar el desvío de haz de electrones sobre ella y el AFM utiliza 

estructuras piezoeléctricas para cambiar el espécimen bajo un punto focal, pero todos 

comparten la misma calidad de imagen y en escala de grises o blanco y negro. Si bien 
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se puede capturar imágenes a color, como en el microscopio AFM y confocal, las 

imágenes son originalmente en formato de blanco y negro y después son traducidas a 

una imagen a color. Generalmente las imágenes poseen una resolución de no más de 

1000x1000 pixeles y su mayor parámetro a controlar para obtener la mejor calidad 

posible es la velocidad de escaneo ya que una rápida velocidad de escaneo minimiza 

el ruido. (Russ, 2005) 

(a)  (b)  (c)  

Fuente: (Agboola et al., 2021) 

Figura 5. Superficie de la Levadura Cyberlindnera jadinni. 

(a)SEM, (b)Confocal, (c)AFM 

 

3.1.3. Color 

El ser humano percibe el color mediante unos sensores llamados conos que traducen 

la energía lumínica (longitudes de onda) en señales nerviosas que a la parte visual del 

cerebro. Estas están conectadas a la parte central de la retina y se pueden dividir en 

3 clases: sensores α (480 nm de longitud de onda) que ve el color azul, los β (540nm 

de longitud de onda) que ve el color verde y los tipos γ que ven rojo (570nm de longitud 

de onda)(Sucar & Gomez, 2015). Con el fin de realizar una representación del color y 

cuantificarlo, se han realizado diversos sistemas de espacios de color, entre ellos 

destacan el RGB, CIE y CIELAB.(Ly et al., 2020) la particularidad que existen entre 

ellos es que se puede pasar de un sistema a otro por medio de una conversión (Ly et 

al., 2020), por lo que la elección de un sistema es un impedimento para exportar los 

valores obtenidos a otro.  



13 

3.1.3.1. RGB 

Es un sistema básico de color, el cual mediante solamente 3 señales combinadas 

aporta el color a una imagen. Estas señales son las de los colores primarios rojo, verde 

y azul (Red, Green y Blue en inglés de ahí su nombre RGB) y sus combinaciones 

aditivas permite los colores secundarios amarillo, magenta y cian (figura 6), la 

combinación de los colores primarios entrega el color blanco, y al combinar todos los 

secundarios obtenemos el color negro (espacio CMYK)(Llasera, 2020; Ly et al., 2020).  

 

Fuente:(Llasera, 2020) 

Figura 6.  Diagrama cromático para el sistema RGB 

 

3.1.3.2. CIE Color 

Es un sistema estandarizado de color el cual separa hue (tono/intensidad), value 

(valor) y chroma (color) en diferentes dimensiones. Este sistema se basa en una 

representación bidimensional de los tres receptores del ojo humano y es reconocido 

con el nombre de CIE 1931 xy (figura 7), el diagrama demuestra como el hue 

representa una absorbancia o reflexión de un largo de onda y value se refiere a la 

luminosidad y chroma se refiere a la saturación (Ly et al., 2020) 
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Fuente:(Agudo et al., 2014) 

Figura 7. Espacio de color de CIE 1931 

 

3.1.3.3. CIELAB 

La Commission Internationale de lÉclairage (CIE), una organización sin fines de lucro 

que es considerada como la autoridad en la ciencia de la luz y el color, ha definido 

espacios de color, el sistema CIELAB o CIE L*a*b* es uno de los espacios de color 

más populares y uniformes para evaluar el color de un objeto representa la relación de 

los colores en tres ejes, L* significa luminosidad, a* y b* representan las coordenadas 

cromáticas o de color.(Ly et al., 2020) 

 

Fuente:(Ramón et al., 2020) 

Figura 8.  Espacio de color de CIELAB 
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Como se observa en la figura 8, L* que es luminosidad es el eje vertical y tiene valores 

desde el 0 (Black, negro) a 100 (White, blanco). El eje a* indica la coloración desde los 

valores negativos verdosos (-a*) hasta los rojizos(+a*) en los valores positivos 

abarcando del -128 al +127 respectivamente, mientras que el eje b* indica la coloración 

azulina (-b*) hasta los colores amarillentos (+b*) en los valores positivos, igualmente 

con la codificación numérica -128 al +127 respectivamente.(Ramón et al., 2020). 

 

3.1.4. Procesamiento de imágenes 

El filtro o procesamiento digital de imágenes es un conjunto de técnicas que se aplican 

a las imágenes digitales con el objetivo de mejorar la calidad. facilitar la búsqueda de 

información. Los principales objetivos que se persiguen con la aplicación de filtros son: 

Suavizar la imagen, al reducir la cantidad de variaciones de intensidad entre píxeles 

vecinos. Eliminar el ruido, al eliminar aquellos píxeles cuyo nivel de intensidad es muy 

diferente al de sus vecinos. Realzar la imagen, al aumentar las variaciones de 

intensidad de un píxel. Y detectar los bordes, al detectar los píxeles donde se produce 

un cambio brusco de color de los pixeles y realzar la función intensidad.(“Percepción 

Computacional: Filtros,” n.d.; Pérez Benito, 2015) 

El ruido de la imagen es un fenómeno muy frecuente que degrada la calidad de la 

imagen y que aparece de improviso en la adquisición, transmisión y/o procesamiento 

de la imagen. En las imágenes digitales se definen como pixeles “erróneos” y 

aleatorios que se mezclan con los pixeles “aceptamos” que componen la imagen y que 

entorpecen su correcta reproducción.(Pérez Benito, 2015). Entre todos los tipos de 

ruido que se puede presenciar, en una imagen el de especial interés el ruido Gaussiano 

y el ruido Impulsivo. El ruido gaussiano es aquel donde todos los pixeles de la imagen 

se ven afectados, cambiando su valor, intensidad e iluminación (Figura 9), y este 

cambio ocurre de acuerdo con una distribución normal o Gaussiana. Este problema se 

presenta en a la adquisición de la imagen por un dispositivo en malas condiciones o 

mala iluminación.(Reducción de Ruido En Una Imagen Digital, n.d.) 
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(a)  (b)  

Fuente:(Pérez Benito, 2015) 

Figura 9. Representación del Ruido Gaussiano  

(a)Imagen original, (b)Imagen con ruido Gaussiano 

 

El ruido impulsivo o sal y pimienta es aquel tipo de ruido donde los pixeles de la imagen 

son diferentes a los pixeles circundantes. Recibe su nombre ya que se podrán divisar 

pixeles blancos sobre puntos negros o vice serba (figura 10) y a diferencia del ruido 

Gaussiano este no afecta a toda la imagen. Es el ruido más presente durante la 

trasmisión de datos por un canal contaminado, o bien debido a los sensores CCD con 

defectos.(Fernández García, 2012; Pérez Benito, 2015) 

(a)  (b)  

Fuente:(Pérez Benito, 2015) 

Figura 10. Representación del Ruido Impulsivo  

(a)Imagen original, (b)Imagen con ruido Impulsivo 

 

Los filtros son técnicas de mejora de la imagen y pueden ser dividas en técnicas 

globales, que operan en toda la imagen o en técnicas locales (especiales), que 
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dependerá de lo que se desee reparar de la imagen. Dentro los filtros estadísticos de 

orden que operan sobre pequeñas regiones y sustituyen el valor del píxel por otro. 

(Fernández García, 2012)Podemos destacar el filtro máximo para arreglar el ruido 

impulsivo de pimienta (negro) el filtro mínimo para arreglar el ruido impulsivo de sal 

(blanco) y el filtro de pinto medio que es adecuado para atenuar el ruido gaussiano. 

Hoy en día existe una inmensa para involucradas en el procesamiento de imágenes 

digitales, con el fin de mejorar la calidad de la imagen para la correcta interpretación 

humana, como identificar de mejor manera radiografías, aplicar filtro infrarrojo para 

mejor identificación de en microscopia, astrología y control de calidad de la 

industria.(“Percepción Computacional: Filtros,” n.d.; Pérez Benito, 2015) 

(a)  (b)  

(c)  (d)   

(e)  (f)  
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Fuente:(Fernández García, 2012) 

Figura 11. Aplicación de filtros para corregir errores de ruido. 

(a)Fotografía de iglesia con ruido gaussiano (b)Fotográfica de iglesia con filtro (punto 

medio) (c)Fotografía de niños con ruido tipo sal (blanco) (d)Fotográfica de niños con 

filtro (mínimo) (e)Imagen de niños con ruido tipo pimienta (negro) (f)Imagen de niños 

con filtro (máximo) 

 

 

3.2. IMAGEJ 

ImageJ es un programa gratuito de análisis y procesamiento de imágenes en formato 

Java y es una que puede ser ejecutado en sistemas operativos como Windows, 

MacOS o Linux.(Bourne, 2010). El software ImageJ (J de Java) es la evolución del NIH 

image (programa del antiguo sistema operativo Macintosh de Apple) y fue desarrollado 

por Wayne Rasband en el Instituto Nacional de Salud de USA. Este programa es un 

software de acceso libre que permite acceder a un set de herramientas listas para 

utilizar con una interfase de fácil manipulación para imágenes, además permite su fácil 

modificación al permitir crear nuevas mejoras (plugins en inglés) a través del manejo 

del lenguaje clásico de programación al poseer el modelo de ejecución dinámico de 

Java (Java´s dynamic execution model) (Burger & Burge, 2016). 

ImageJ es un software que puede mostrar, editar, analizar, guardar e imprimir 

imágenes en diversos formatos. De igual manera puede realizar operaciones como 

cambiar la forma de productos, conversión a diversas escalas, modificación de la 

imagen y permite realizar varios tipos de medidas (conteo de unidades, medición de 

distancias, ángulos y áreas) que involucren a la imagen que está analizando.(Radu et 

al., 2021). Como se observa en la figura 12, a partir del ImageJ se han creado varios 

softwares populares como una extensión del software original, como son Fiji (“Fiji is 

Just ImageJ”) e ImageJ2, los cuales a partir de la interfaz de ImageJ se han 

especializado en distintas ramas científicas, dando un enfoque biológico a su 

utilización.(Burger & Burge, 2016) 
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El ImageJ al ser un programa de fuente abierta y gratuita cumple con las cuatro 

libertades esenciales: el uso del programa para cualquier propósito, la libertad de 

estudiar el funcionamiento del programa y cambiarlo según los deseos y necesidades, 

la libertad de distribuir copias de este y finalmente, la libertad de compartirlo de manera 

abierta junto con los beneficios de este a todo el público (Lind, 2012; Rueden et al., 

2017a). 

 

Fuente:(Schroeder et al., 2021) 

Figura 12. Diagrama de la evolución de NIH al ImageJ actual. Mejoras y 

herramientas de Fiji  

(a)Registro, (b)Segmentación, (c) Registro, (d)Herramientas de medición.  

 

Considerando lo anterior, se considera el ImageJ como una buena herramienta de 

apoyo educacional para el procesamiento y análisis de imágenes. Se ha demostrado 

que el software es de fácil comprensión para las nuevas generaciones y que 

experimentos científicos se pueden adaptar para estimular la participación de los 

estudiantes, generando una mejor comprensión y aplicación de los conceptos 

estudiados a través de las nuevas tecnologías. Un ejemplo del uso de ImageJ dentro 

“Baterías de la Aplicación” (2007) 

Legado de ImageJ 
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del ambiente profesional es realizado por Radu donde se implementó en un taller de 

física de ópticas de la luz el uso de ImageJ como herramienta de edición y aplicación, 

y declara que es la plataforma ideal para educar y entrenar utilizando el procesamiento 

de imágenes, ya que los estudiantes no tuvieron problemas en el manejo y desempeño 

de este, pudiendo capturar la instancia por medio de sus teléfonos y pudieron analizar 

posteriormente los resultados sin problemas.(Radu et al., 2021) 

El software ImageJ puede ser utilizada como herramienta de uso educacional en el 

área de procesamiento y análisis de imágenes digitales, al poseer las características 

como: 1) Interfaz de fácil acceso, gratuito y compatible con todo sistema operativo.2) 

Fácil comprensión y reproducción de ejercicios. 3) Gran eficiencia, al disminuir los 

tiempos de medición y certeza en sus mediciones, al comparar una medición in situ 

versus una realizada por una fotografía. 4) Actualización constante del sistema por 

medio de los plugins o herramientas creadas por los mismos usuarios. 6) Análisis como 

son identificación de color, predicción de unidades u mediciones a través de imágenes. 

6) Disponibilidad de materiales pedagógicos explicativos del uso y aplicaciones del 

software, como son tutoriales en forma de videos explicativos como manuales. 

 

3.2.1. Aplicaciones de ImageJ 

El procesamiento digital de imágenes involucra metodologías para el análisis de 

imágenes y es útil para obtener información cualitativa y cuantitativa. El avance 

tecnológico en el desarrollo de hardware y software ha provisto herramientas para la 

captura de imágenes y algoritmos para el análisis que permiten evaluar de manera no 

destructiva y objetiva, por ejemplo, el color.(Padrón-Pereira et al., 2016) 

Existen diversas aplicaciones en las ciencias sobre el uso del ImageJ, si bien no todas 

son aplicables para las ciencias de los alimentos, se investigará las aplicaciones que 

más se destacan por su uso y efectividad: recuento de unidades, identificación de 

tamaño, área y recolección de color.  
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3.2.1.1. Recuento y predicción de unidades 

En el campo de las ciencias el programa entrega análisis objetivo de mediciones en 

varios parámetros de plantas. Un ejemplo de ellos es el análisis de fenotipos de 

semillas y análisis de plantas enteras, recordando que el fenotipo es la apariencia física 

de la planta como la unión del genoma y del medioambiente (Lind, 2012). 

(a)  (b)  

Fuente:(Lind, 2012) 

Figura 13. Ejemplo de recuento de semillas.  

(a)Imagen de semillas usando un escáner, (b)Análisis de la imagen de sus 

características morfológicas como largo, perímetro, área, etc. Y de características 

cuantitativas como la identificación del número de semillas. 

 

En la figura 13, se observa como el uso del ImageJ en el recuento de semillas, como 

el control de estructuras reconoce las estructuras y permite representar en ellas (con 

la línea blanca) la máxima longitud de la semilla (Lind, 2012).Así mismo, puede calcular 

el número de semillas, un promedio de tamaño entre ellas, el valor de largo máximo o 

mínimo de manera automática, características que de ser realizas de manera manual 

tomaría bastante tiempo de medición considerando que son 81 semillas de 

aproximadamente 1mm de largo. 

 

3.2.1.2. Identificación de tamaño y área  

Otra demostración del uso de ImageJ como medición de tamaño. La medición del largo 

de los peces es útil para explorar el tamaño de los peces de pesca y de los efectos de 
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la pesca en los espacios marinos. La medición manual de los peces de una gran 

cantidad de especímenes requiere un largo tiempo debido a la manipulación de los 

peces en especial en los peces tropicales debido a su pequeño tamaño y delicada 

manipulación (Andrialovanirina et al., 2020). Debido a lo anterior, el programa permite 

realizar las mediciones de manera automática, realizando una imagen con el total de 

los peces de interés (figura 14.a). Los resultados obtenidos por medio de este ejemplo 

permitieron divisar que por el método tradicional el tamaño promedio de los peces 

tropicales fue de 8.8± 7cm, usando el programa de medición uno a uno de ImageJ se 

obtuvo un valor de 8.7±7cm y usando el predictor del ImageJ dio un valor de 8.8±7cm. 

(a)  (b)  

Fuente:(Andrialovanirina et al., 2020) 

Figura 14. Imagen de escáner de los peces a analizar.  

(a)Imagen original a color de los diferentes pesces, (b)Intersecciones de las regiones 

de interés (ROIs) por el proceso automático de ImageJ 

 

Por lo tanto, los resultados obtenidos presentaron una certeza de un 98% con respecto 

a la medición manual y reduce en un 57% el tiempo de la medición utilizando el método 

predictivo presentado en la figura 14.b considerando una medición de 646 peces de 

tamaños entre 3 a 50cm (Andrialovanirina et al., 2020). 

 

3.2.1.3. Análisis de color  

En alimentos, el color es una parte importante del aspecto visual, uno de los factores 

principales utilizados por el consumidor al momento de la compra de un producto y se 
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utiliza en muchos estándares de clasificación como criterio de calidad. El color es un 

parámetro de calidad utilizado para evaluar el estado de maduración de frutos. 

Herramientas comúnmente empleadas en el diseño gráfico, como cámaras digitales, 

computadoras y software editor de imágenes, pueden ser utilizadas para procesar y 

analizar imágenes mediante la implementación de lo que se denomina un sistema de 

visión computarizada, para determinar el color de muestras de alimentos y durante la 

maduración de frutos; lo que permite sustituir en gran medida, el uso de cartas de 

colores, colorímetros y espectrofotómetros.(Padrón-Pereira et al., 2016) 

Las nuevas aplicaciones de análisis de imágenes digitales y tecnologías de libre 

acceso han impactado en diversas áreas como la Agroalimentaria, y, específicamente, 

en los procesos de evaluación sensorial (color y forma) con o sin instrumentos. Un 

ejemplo de estos es la comparación de análisis entre un panel sensorial y análisis 

digital por Photoshop e ImageJ, donde se buscaron los valores promedio de las 

imágenes de manera digital, posterior a su segmentación(Césari Matilde et al., 2020). 

Demostrado que se correlacionan estrechamente con los de la evaluación sensorial 

visual del color, representado un procedimiento práctico, que permite la medida del 

color sensorial en forma rápida y directa, con la suficiente aproximación y objetividad 

aceptable, para su fácil transferencia al medio productivo. Se verificó que en el caso 

del procesamiento de imágenes digitales utilizando el software ImageJ, se puede 

realizar un análisis rápido de la totalidad de la imagen, y de las coordenadas de color, 

que pueden transformarse del espacio RGB a L*a*b* con alta calidad, incluso superior 

a Photoshop. 

(a)  
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(b)  

Fuente :(Césari Matilde et al., 2020) 

Figura 15. Ejemplos de selección y promediado de muestra de zanahoria. 

(a)Selección de zanahoria rallada por Photoshop, (b)Selección de zanahoria en 

trozos por ImageJ 

 

Otro ejemplo de la medición de color se realizará de manera simultánea la medición 

de color y de tamaño, en este caso de una planta, acción que no es posible realizar 

con el ojo humano. Reconociendo que las hojas de las plantas pueden presentar una 

variedad de tonalidades y que pueden ser clasificadas en diferentes categorías (Lind, 

2012). Así mismo se observa como el programa puede medir la dimensión total de la 

planta e identificar el porcentaje de color dentro de la misma a partir de su imagen en 

escala de grises. 

(a)  (b)  

Fuente: (Lind, 2012) 

Figura 16. Ejemplo de medición del fenotipo de una planta.  

(a) Imagen de la planta convertida a escala de grises, (b) Cuantificación del fenotipo 

de una planta según la clasificación de sus diferentes áreas de color. 
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4. APORTE AL CONOCIMIENTO 

La aplicación de herramientas tecnológicas en el ámbito educativo ha experimentado 

un crecimiento significativo en las últimas décadas, brindando oportunidades únicas 

para la enseñanza y el aprendizaje en diversas disciplinas. En este contexto, las 

Ciencias y Tecnologías de los Alimentos han emergido como un campo 

multidisciplinario esencial que demanda enfoques innovadores para la comprensión y 

aplicación de sus conceptos fundamentales. 

La elección de ImageJ como herramienta educativa se sustenta en su accesibilidad, 

versatilidad y la posibilidad de adaptarse a diferentes niveles académicos. Este 

software permite el análisis cuantitativo y cuantitativo de imágenes, lo que resulta 

especialmente útil en la evaluación de procesos y productos alimentarios, así como en 

la investigación de características microestructurales y propiedades morfológicas 

relevantes. Además, su aplicación en el contexto de las Ciencias y Tecnologías de los 

Alimentos es una herramienta que puede ser ampliamente explorada, ya que aún no 

existe una limitante en sus usos y aplicaciones, lo que deja abierta la investigación. 
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5. OBJETIVOS 

5.1. OBJETIVO GENERAL 

Evaluar el uso de ImageJ como herramienta en el ámbito de las Ciencias y Tecnologías 

de los Alimentos, con el propósito de proporcionar su comprensión y utilización por 

medio de la elaboración de un instructivo, aportando habilidades prácticas de los 

estudiantes en el análisis de imágenes y datos asociados a dicha disciplina. 

 

5.2. OBJETIVO ESPECÍFICOS 

1) Demostrar el uso del programa ImageJ como herramienta actual para el análisis 

de imagen en el ámbito Científica. 

2) Validar la aplicación del software ImageJ por medio de la realización de ejemplos 

de análisis estandarizados de color, largo, recuento de unidades en imágenes 

capturadas en una cámara oscura y por medio de un escáner. 

3) Comparar la diferencia en los resultados del software entre una imagen 

estandarizada y no estandarizada por medio del análisis de color, largo y recuento 

de unidades. 

4) Comprobar la reproducibilidad del uso del software al recrear los análisis de 

imagen realizado en publicaciones científicas para el recuento de UFC y 

emulsiones. 

5) Desarrollar un instructivo de uso del software ImageJ, para ser utilizado por la 

carrera de Ingeniería en Alimentos. 

6) Validar el funcionamiento del instructivo de ImageJ por medio de una evaluación 

online de parte de los estudiantes de la carrera de Ingeniería en Alimentos de la 

Universidad de Chile por medio de desafíos de ejecución de medición de color y 

recuento de unidades. 

7) Mostrar la aplicación de las herramientas disponibles del software ImageJ en 

alimentos chilenos. 
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6.  METODOLOGÍA 

 

Figura 17. Diagrama de metodología. 

 

1) Estado del Conocimiento Científico: Se recopilará información bibliográfica de 

usos del ImageJ en la comunidad científica, en las bases de datos de Web Of 

Science (WOS) medir su uso y su efectividad como herramienta actual de análisis 

de imagen por medio de una métrica de publicaciones y métrica de citaciones. 

2) Análisis de Imágenes Estandarizadas: Se realizará un análisis de imagen a 

semillas (2-6 gramos dependiendo del tamaño) capturadas por un escáner y a 

frutos capturados de forma rotatoria en una cámara oscura (Figura 18). 

3) Análisis de Imágenes no Estandarizadas: Se realizarán fotografías a condiciones 

normales de luz artificial con fondo blanco o negro según corresponda a los mismos 

elementos fotografiados en las Imágenes estandarizadas. El fondo blanco semillas 

y los frutos en fondo negro y se comparan los resultados de los análisis 

estandarizados con los no estandarizados. 
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Análisis de 
Imágenes

Análisis de 
Imágenes 

Estandarizadas

Analisis de 
Imágenes No 

Estandarizadas
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Difusión Científica

Realización del 
Instructivo

Validación del 
Instructivo
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4) Análisis de Imágenes de Difusión Científica: Se elegirán imágenes de recuento 

de UFC y de emulsiones, debido a su mayor aplicación en el rubro de alimentos, 

que cuenten con la metodología de realización del análisis de imagen. Con la 

finalidad de obtener los datos correspondientes y compararlos. 

5) Realización del Instructivo: Por medio del conocimiento y manejo del software de 

análisis de imágenes ImageJ, se realizará un manual ilustrativo que presente el 

paso a paso del uso del programa para su utilización en el laboratorio de Ciencias 

y Tecnologías de los Alimentos de la Facultad de Ciencias Químicas y 

Farmacéuticas de la Universidad de Chile. 

6) Validación del Instructivo: Por medio de un ejemplo de análisis de un alimento 

definido, se le otorgará el instructivo a alumnos de la facultad de ciencias químicas 

y farmacéuticas de la universidad de Chile. Por medio de una encuesta online y 

posterior análisis de resultados se investigará si el instructivo fue: 1) de fácil 

comprensión, 2) se logró el objetivo de la medición de color, área y recuento e 

identificación de unidades de una imagen y 3) retroalimentación y finalmente se 

realizará una comparación de los resultados originalmente en el análisis con los 

esperados. 

7) Análisis de Casos Alimentos Chilenos: Se realizará el análisis de imágenes de 

frutos chilenos aplicando diversas herramientas y plugins disponibles por el 

software ImageJ para realizar el análisis morfométrico, de color y textura de los 

frutos. 
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7. MATERIALES Y MÉTODOS 

7.1. CAPTURA DE IMÁGENES 

7.1.1.  Escáner 

El éscaner utilizado es de la marca Brother®, una impresora multifuncional modelo X-

201.Este consiste en una cama plana de 21,6x29,7cm con sensor de líneas CIS de 

color, con una resolución de 1200x2400dpi y profundidad de color de 48bits. 

 

7.1.2. Cámara obscura 

La cámara obscura consiste en un fondo negro con dos tubos de PVC conduit 

concéntricos cuyo giro permite capturar el fruto desde todos sus ángulos, sin 

necesidad de sacar la muestra de la cámara. Detrás de la cámara se ubica el sistema 

de iluminación, el cual consta de dos tubos fluorescentes T4 de 6 Watts de potencia 

de tamaño pequeño (20 cm de largo) y un color temperatura de 6500K, utilizados 

comúnmente para análisis de alimentos. La distancia entre el fruto y la cámara es de 

18cm y la dimensión de la base es de 2,5 cm de diámetro.  

(a)  (b)  

 

 

Figura 18. Esquema de la cámara obscura. 

(a)Vista superior, (b)Vista lateral. 
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7.1.3. Cámara digital 

La cámara utilizada es de celular de la marca Samsung® el modelo Galaxy S20 FE 

del año 2021, la cual posee una cámara principal de 12MP, f/1.8, OIS. Para la captura 

se utilizará el modo normal, con dimensiones guía, tipo de foto 1:1 y resolución de 

1600x1200píxeles.El equipo será utilizado a distancia por medio de la Aplicación 

Samsung Flow para asegurar la mejor posición de imagen en su uso de la cámara 

obscura y será utilizada con las mismas condiciones para fotografiar las condiciones 

no estandarizadas. 

 

 

7.2.  ANÁLISIS DE IMÁGEN  

El análisis de Imágenes será realizado con el programa ImageJ versión 1.54h 

(https://imagej.nih.gov/ij/download.html), utilizando las herramientas básicas que 

cuenta el programa como son Line, Multipoint, Set Scale, Analyze Particles, ROI 

Manager, entre otros. Como también el plugins disponibles en línea como el programa 

Cell Counter (https://imagej.nih.gov/ij/plugins/download/jars/cell_counter.jar). Además 

del uso del software Adobe Photoshop® versión 23.4.1 20220615.r.547 3121b66  x64 

(https://www.adobe.com/cl/products/photoshop/landpa.htm) para la comparación de 

comparación en dicho análisis. Los plugins deben ser descargados de los 

correspondientes links y dicho archivo es arrastrado al programa ImageJ (abierto) para 

su instalación automática, posteriormente se reinicia el programa para su correcto 

funcionamiento y se encontrarán en el menú plugins de ImageJ. 

A continuación, se detallarán los procesos realizados para la realización del análisis 

de imágenes por los dos softwares mencionados anteriormente, para cada uno de los 

casos de estudios que se realizarán los análisis por triplicado: Recuento y predicción 

de semillas, Análisis de tamaño. Análisis de color, Análisis de emulsiones y Recuento 

de unidades formadoras de colonias (UFC).  

 

https://imagej.nih.gov/ij/download.html
https://imagej.nih.gov/ij/plugins/download/jars/cell_counter.jar
https://www.adobe.com/cl/products/photoshop/landpa.htm
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7.2.1. Recuento y predicción de semillas 

Las semillas fueron contabilizadas por la herramienta análisis de partículas de ImageJ 

la cual permite predecir la cantidad de objetos presentes en la imagen y finalmente se 

realizó un conteo manual con la herramienta Multipunto (Muti-point + Ctrl M) del 

mismo programa. Se realizaron los análisis con tres tipos de semillas diferentes, los 

cuales fueron seleccionados según el tamaño de semilla se seleccionaron muestras 

de 2 y 6 gramos para medir su cantidad y reconocimiento de semillas partidas. Se 

pesaron 6 gramos de semillas de zapallo, 6 gramos de semillas de maravilla y 2 

gramos de semillas de sésamo.  

  

 

En cada caso la misma muestra fue fotografiada por medio de un escáner (imagen 

estandarizada) y por medio de la cámara del celular sobre una hoja blanca (imagen no 

estandarizada). En la figura 19, se observan las semillas de sésamo en el escáner y 

como se observa la definición de cada una por medio de zoom. Con el fin de tener una 

dimensión de comparación para las semillas se escaneó de manera análoga una regla 

de 30cm para tener la escala de referencia en el programa ImageJ. Medimos la 

distancia con la herramienta línea (Straight + Clic izquierdo y arrastrar hasta el 

final) posteriormente ingresar a la distancia conocida (Analyze > Set Scale > Global 

> OK), en este caso 1 cm y se acepta el global, como se observa en la Figura 20. 

Figura 19. Escáner de 2 gramos de semillas tostadas de sésamo, con zoom a 

sus semillas 
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Figura 20. Set Scale para análisis con escáner. 

 

7.2.1.1. Recuento automatico 

Para utilizar el análisis de partículas, a cada imagen que se encontraba en formato 

RGB se le ajustó el contraste para posteriormente se convierta en 8bits (Image > Type 

> 8-bits), corregir su tono buscando dejar toda el área de interés en negro(Imagen > 

Adjust > Threshold > Apply) retirar el ruido (Process > Noise > Despickle) de la 

imagen y separar las estructuras negras con la herramienta Watersheld (Process > 

Binary > Watersheld) para finalmente aplicar el análisis de partículas (Analyze > 

Analyze Particles). Para el correcto funcionamiento de la herramienta a la imagen se 

le debió aplicar Threshold. 
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(a)  (b)  

(c)  

I)  

II)  

 

7.2.1.2. Recuento manual 

Para el conteo manual se realizó con la herramienta Multi-Point (Multipoint + clic 

izquierdo). Se realiza el conteo del clic sobre la imagen y registran las mediciones con 

la herramienta Measure (Analyze > Measure /Ctrl+ M)  

Figura 21. Uso de ImageJ para identificar el número de semillas 

(a)Imagen original, (b)Imagen con Threshold y separación de estructuras, (c)Análisis 

de partículas: I) Recuento del análisis II) Recuento de estructuras. 
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(a)  (b)  

(c)  

(d)  

 

7.2.2. Análisis de tamaño 

El análisis de tamaño fue realizado por medio de ImageJ con la herramienta de Línea. 

Se tienen 3 muestras de Tomates Cherries a las cuales se les medirá las dimensiones 

de alto, largo y ancho por medio de un Pie de Metro y se comprará con las medidas 

obtenidas de largo, alto y ancho obtenidas por el programa. 

Para realizar el procedimiento de medición de largo y ancho de las frutas por medio de 

ImageJ será necesario iniciar con estandarización de la imagen, por medio de una 

fotografía con la imagen. Medir la distancia conocida con la herramienta línea (Straight 

+ Clic izquierdo y arrastrar hasta el final) posteriormente ingresamos a la distancia 

conocida (Analyze > Set Scale > Global > OK) Ingresamos la distancia conocida y se 

Figura 22. Conteo manual de unidades por medio ImageJ 

(a) Imagen Original, (b) Imagen con semillas contadas, (c)Measure, (d) Registro del 

recuento. 
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acepta el global, el proceso es el mismo que se observa en la Figura 20, pero con la 

nueva unidad (diámetro de la base 2,5cm).Posteriormente se miden las imágenes con 

la herramienta línea (Straight + Clic izquierdo y arrastrar hasta el final) y se 

registran las distancias con la herramienta Measure (Analyze > Measure /Ctrl+ M) 

(a)  
(b)  

(c)  

(d)   (e)  

(f)  

 
  

Figura 23. Procesamiento de imágenes para la identificación de tamaño. 

(a)Imagen original, (b)Menú de Set Scale, (c)Set Scale, (d)Análisis de ancho, 

(e)Measure, (f)Resultados (con largo en cm). 
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7.2.3. Análisis de color 

El análisis de color fue realizado por medio de dos programas ImageJ y Photoshop. 

Para la realización del análisis de color se fotografiaron tres muestras de Frutillas. En 

ambos casos se realizó en primera instancia la fotografía en la cámara obscura y 

posteriormente en las condiciones estándar del laboratorio a aproximadamente 18cm 

de la muestra y se fueron rotando en ángulos de 90° para obtener una visión total del 

fruto. 

Las fotografías de frutas destinadas para al análisis de color presentan diferente 

coloración en sus hojas o sus semillas. Estas regiones, si no son excluidas, ocasiones 

errores en el cálculo del color promedio de las muestras y para evitarlo se realizó una 

técnica de regiones para subdividir las imágenes en regiones de interés y de 

discriminación basado en el indicado por Padrón, donde se elimina el máximo y mínimo 

brillo de la imagen y las regiones exteriores no pertenecientes a la cáscara (Padrón-

Pereira et al., 2016). Se compararán los colores recolectados por medio de la rueda 

cromática de Adobe Color (https://color.adobe.com/es/create/color-wheel), 

herramienta gratuita online donde se ingresará con el modo de color CIELAB (Modo > 

LAB).  

 

7.2.3.1. ImageJ 

Para la identificación del color por medio de ImageJ se basó en el realizado por Lizama 

(Lizama García, 2019), pero con las modificaciones señaladas anteriormente. La 

medición se realizará por medio de la selección del área total y la eliminación del brillo/ 

manchas más notorias. La imagen fue transformada de espacio RGB a CIELAB por 

medio del mismo programa (Image > Type > Lab Stack), opción que abrirá una 

ventana que cuenta con 3 vistas (L*, a*, b*). La posterior medición de color. se realizará 

por medio de la herramienta Polygon Selections, se traza el contorno del fruto y se 

eliminan las partes no deseadas con la misma herramienta (Alt+ Clic izquierdo). El 

Strazo guardado en Resultados con la herramienta Measure (Analyze > Measure 

/Ctrl+ M) es posible identificar los valores promedio de 𝐿∗, 𝑎∗𝑦 𝑏∗ midiendo para cada 

uno de los valores, como se observan en la figura 24.b). 

https://color.adobe.com/es/create/color-wheel
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(a)  

(b) (L*) 

 

(a*) 

 

(b*) 

 

(c)  

(d)  

 

7.2.3.2. Photoshop 

Por medio del programa se abrió la imagen y se cambió los reguladores RGB por los 

reguladores L*a*b* (Imagen > Modo > Color Lab) posteriormente en el menú 

selección se abrió la ventana gama de colores, se selección la opción muestreados y 

previsualización con mascara rápida (Selección > Gama de colores >Muestreados 

+ Invertir + Previsualizar selección: Máscara Rápida). Con la herramienta 

Figura 24.  Procesamiento de imágenes para determinar el color en ImageJ.  

(a)Frutilla inicial (RGB), (b)Imagen en CIELAB (se presentan las 3 imágenes que la 

componen (L*), (b*), (a*). (c)Segmentación secuencial para obtener la región de 

interés, (d)Ventana de ROI Manager, (f)Análisis de color en CIELAB. 
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cuentagotas se tomó una muestra del criterio de tamaño un punto del centro de color, 

distinto a la sombra y/o manchas obscuras (opción que selecciona todos los colores 

semejantes, manchas y con brillo y los excluyó del promedio de los pixeles), luego en 

el menú filtro se seleccionó el submenú desenfocar, opción promediar (Filtro > 

Desenfocar > Media) y automáticamente realiza la sumatoria de todos los píxeles de 

la imagen, menos las sombras, manchas y/o brillanteces seleccionadas (Cuentagotas 

+ Clic derecho > Muestra de color). 

(a)  
(b)  

(c)  

(d)  

(e)  

Figura 25.  Procesamiento de imágenes para determinar el color en Photoshop. 

(a)Frutilla inicial en modo CIELAB, (b)Menú de Gama de colores, (c)Segmentación 

secuencial para obtener la región de interés, (d)Menú de desenfoque, (e)Color medio 

de la frutilla y Selección del color. 
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7.2.4. Análisis de emulsiones 

Para la realización del análisis de emulsiones se utilizaron las imágenes obtenidas por 

Wang en su investigación sobre la estabilidad en el tiempo de las emulsiones Pickering 

(Anexo 2). La elección de esta publicación no solo es por la diversidad de tamaños de 

partícula obtenido a lo largo de la formulación, sino que debido a aplicabilidad de las 

emulsiones Pickering en la industria alimentaria para la preparación de emulsiones con 

propiedades texturales específicas y alta estabilidad oxidativa. Estas se caracterizan 

como estabilizadores de sistemas de emulsiones, ya que no solo brindan una alta 

resistencia a la fase de separación, alta biocompatibilidad, entre otros y puede ser de 

ayuda para prevenir la oxidación de la luz. (Wang et al., 2023) 

Para utilizar el análisis de emulsiones, a cada imagen que se encontraba en formato 

RGB se le ajustó el contraste para posteriormente se convierta en 8bits (Image > Type 

> 8-bits), corregir su tono buscando dejar toda el área de interés en negro (Imagen > 

Adjust > Threshold > Apply) retirar el ruido (Process > Noise > Despickle) de la 

imagen. Se separan las estructuras negras con la herramienta Watersheld (Process 

> Binary > Watersheld) para finalmente aplicar el análisis de partículas (Analyze > 

Analyze Particles). Para el correcto funcionamiento de la herramienta a la imagen se 

le debió aplicar Threshold. En caso de ser necesario se puede aplicar nuevamente el 

retirar el sonido previo a la separación para limpiar de mejor manera la estructura. 
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(a)  (b)  

(c)  

I)  

II)  

 

7.2.5. Recuento de unidades formadoras de colonias (UFC) 

Se realizó el análisis de UFC a las imágenes obtenidas por Stolze en su investigación 

sobre el cultivo de hongos de marihuana medicinal y su recuento de UFC por medio 

de ImageJ (Anexo 1) y que presentó un estudio cuantitativo y cualitativo con 

participantes para realizar el análisis. Dicha investigación se debe a que el control y 

testeo de la industria de alimentos de alimentos y marihuana, tiene un requerimiento 

el control de bacterias y hongos para las regulaciones federales, al menos de Estados 

Unidos, desde que la marijuana fue legalizada es de especial intención la 

determinación de levaduras y hongos totales presentes en los productos para evaluar 

problemas de salud, debido a lo anterior el análisis de las levaduras y hongos en las 

Figura 26. Uso de ImageJ para recuento de diámetro de partículas para 

emulsiones. 

(a)Imagen en 8-bits, (b)Imagen con Threshold y con separación de estructuras, 

(c)Análisis de partículas: I) Recuento del análisis II) recuento de estructuras. 
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muestras puede generar un problema debido a la gran concentración y superposición 

de las colonias lo que genera un problema para su recuento.(Stolze et al., 2019) 

 

7.2.5.1. Recuento manual  

Para el conteo manual se realizó con la herramienta adicional “Cell Counter” (Plugins 

> Cell Counter)(Stolze et al., 2019). 

(a)  (b)  

 

7.2.5.2. Recuento automático 

Para utilizar el análisis de unidades formadoras de colonias, a cada imagen se le retira 

el fondo exterior a la placa Petrifilm, para ello marcamos el área de la placa (Oval > 

Edith > Clear Outside). La imagen que se encuentra formato RGB se le ajustó el 

contraste para posteriormente se convierta en 8bits (Image > Type > 8-bits), corregir 

su tono buscando dejar toda el área de interés en negro, es decir con fondo blanco 

(Imagen > Adjust > Threshold). Convertimos la imagen a una “máscara” (Process > 

Binary > Convert to Mask) y separar las colonias con la herramienta Watersheld con 

1 pixel de ancho (Process > Binary > Watersheld) para finalmente aplicar el análisis 

de partículas (Analyze > Analyze Particles).  

 

Figura 27.  Conteo manual ImageJ de células en Petrifilm. 

(a)Imagen Original, (b)Cell Counter 
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(a)  (b)  

(c)  

I)  

II)  

 

 

7.3. VALIDACIÓN DEL INSTRUCTIVO “USO DE IMAGEJ” 

Para la validación del manual se contactó con alumnos de la Facultad de Ciencias 

Químicas y Farmacéuticas de la Universidad de Chile. Por medio de una encuesta 

online realizada por el formulario de Google, la cual consistía en un análisis cualitativo 

del uso del instructivo el cual fue medido en tres etapas. 

Primera etapa de evaluación de instalación: 1) si es posible instalarlo y en qué sistema 

operativo. La segunda etapa, por medio del uso del “Instructivo de uso de ImageJ” 

realizar el análisis de recuento de semillas, color y UFC (Figura 29), donde se 

Figura 28. Conteo automatizado por ImageJ de células en Petrifilm. 

(a)Imagen original, (b)Imagen Threshold, (c) Análisis de partículas: I) Resultados, II) 

Sombreado de cada partícula analizada. 
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identificará si instructivo fue: 1) de fácil comprensión, 2) se logró el objetivo de la 

medición de color, área y recuento de unidades de una imagen y la última etapa 

retroalimentación. Posteriormente se realizará el análisis cuantitativo de los resultados 

obtenidos por los participantes en relación con los obtenidos en el análisis de casos. 

Con la información cualitativa recolecta de la experiencia se realizaron modificaciones 

en el instructivo, que permitirán su mejor aplicación y fluidez en el uso. 

Recuento de semillas Análisis de color Recuento de UFC 

   

 

 

7.4. ANÁLISIS DE CASOS 

El análisis de casos será realizado con el programa ImageJ versión 1.54h 

(https://imagej.nih.gov/ij/download.html), utilizando las herramientas básicas que 

cuenta el programa como son Line, Multipoint, Set Scale, Analyze Particles, ROI 

Manager entre otros. Como también el plugins disponibles en línea como: GLCM 

Texture (https://imagej.net/ij/plugins/texture.html), Extended ToolBox 

(https://imagej.net/plugins/biovoxxel-toolbox#Extended_Particle_Analyzer) y SDBC 

(https://github.com/perchrh/ImageJFractalDimension?tab=readme-ov-file ).Los 

análisis realizados a los alimentos chilenos (piñón y arándano) serán basados en el 

trabajo de Baima, quién realizó análisis morfométricos, de color, de textura y fractal 

utilizando las herramientas de ImageJ (Baima & Ribotta, 2019) 

  

Figura 29. Imágenes seleccionadas para análisis. 

https://imagej.nih.gov/ij/download.html
https://imagej.net/ij/plugins/texture.html
https://imagej.net/plugins/biovoxxel-toolbox#Extended_Particle_Analyzer
https://github.com/perchrh/ImageJFractalDimension?tab=readme-ov-file
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7.4.1. Materiales 

7.4.1.1. Piñón (Araucaria Araucana) 

El piñón es la semilla fruto del árbol Araucaria (Araucaria araucana) que es un árbol 

nativo de Chile y Argentina, y que es un monumento natural ya que su forestación no 

supera los 450.00ha y de la cual el 74% se encuentra en Chile, especialmente en la IX 

Región (Escobar Álvarez & Estévez A, 2008; Fundación para la Innovación Agraria, 

2010).Los piñones es un alimento importante dentro de la cultura Mapuche, 

especialmente en la etnia Pehuenche. Su recolección es principalmente en otoño, pero 

su disponibilidad a granel a nivel nacional ya que se comercializa la semilla seca. Sus 

características morfológicas presentan la semilla son formada de una cubierta externa 

alargado, cuneiformes, de un atractivo color pardo rojizo, de 3,5 a 4,5 cm de largo, 

entre 1,2 a 2,0 cm de ancho y con un peso de 3,5 a 4,0 gramos (Cortés et al., 2019; 

Escobar Álvarez & Estévez A, 2008; Fundación para la Innovación Agraria, 2010). 

Si bien existe un mercado internacional para piñones (Pinus pinea), el piñón chileno al 

provenir del árbol protegido del país no se exporta como materia prima, pero en los 

últimos años se ha considerado exportarlo como producto elaborado de producción y 

control regional, debido a su recolección y respeto por nuestras raíces (Fundación para 

la Innovación Agraria, 2010). 

Para el análisis de casos utilizaremos 30 unidades (aproximadamente 25 gramos) de 

piñón chileno, los cuales fueron fotografiados con luces led, sobre un fondo blanco y 

una barra de medida de 2cm como referencia. La elección de la semilla es debido a su 

estacionalidad, importancia histórica (ancestral) y por su apariencia corniforme 

alargada, atractivo color y textura superficial. 

 

7.4.1.2. Arándano (Vaccinium Corybosum) 

El arándano es la cuarta fruta de interés económico en el mundo, debido al contenido 

de antioxidantes y a la resistencia del cultivo a condiciones ambientales adversa. Es 

una fruta muy apreciada por los países del hemisferio norte, principalmente Estados 

Unidos de América (56%) y algunos países de Europa (22%) y dicha exportación 2023-
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2024 fue de 82mil toneladas del fruto fresco.(Fresh Plaza, 2024; MundoAgro, 2023; 

Pinedo Montoya, 2019) 

Son bayas regulares casi esféricas azules de 1 a 3 gramos de peso, dependiendo de 

la especie y el cultivar puede variar en tamaño de 7 a 15m, de diámetro, en casos de 

frutos comerciales pueden llegar a los 21milímetros de diámetro. Dentro de las 

características de calidad comercial se destacan el calibre (diámetro inferior a 12mm), 

forma (irregular), color (verde, 10% de su superficie o rojizo ,20% de su superficie) o 

defecto de su condición como la deshidratación del fruto (aparición de arrugas en la 

piel del fruto por la pérdida de agua).(Comité de Arándano de Chile & Asociación de 

Exportadores de Frutas de Chile (Asoex), 2013; Fresh Plaza, 2024; Pinedo Montoya, 

2019) 

Para el análisis de casos utilizaremos 3 unidades de arándano frescos adquiridos de 

un distribuidor nacional hortícola, los cuales fueron fotografiados cada 45° por lado con 

la cámara oscura, considerando los 2,5 cm de base como referencia. La elección del 

fruto es debido a su disponibilidad anual, importancia como fruto de exportación y por 

su apariencia homogénea circular, de color uniforme y suave textura. 

 

7.4.2. Análisis morfométrico y color 

7.4.2.1. Análisis morfométrico 

Mediremos la morfología utilizando el plugin Extended Particle Analyze (Análisis de 

partículas Extendido) perteneciente al paquete de herramientas Extended ToolBox. 

Medir la distancia conocida con la herramienta línea (Straight + Clic izquierdo y 

arrastrar hasta el final) posteriormente ingresamos a la distancia conocida (Analyze 

> Set Scale > Global > OK). A cada imagen que se encontraba en formato RGB se le 

ajustó el contraste para posteriormente se convierta en 8bits (Image > Type > 8-bits), 

corregir su tono buscando dejar toda el área de interés en negro (Imagen > Adjust > 

Threshold > Apply), retirar el ruido (Process > Noise > Despickle) de la imagen para 

finalmente aplicar el análisis de partículas extendido (Plugins > BioVoxxel > 
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Extended Particle Analyze). Para el correcto funcionamiento de la herramienta a la 

imagen se le debió aplicar Threshold. 

Mediante la realización de dicho análisis obtendremos de manera automática los 

parámetros morfométricos de área (cm2), perímetro (cm), circularidad (similitud del 

objeto comparado con un referente perfectamente circular, donde 1 es un círculo 

perfecto), diámetro de Feret(mayor distancia de separación entre dos pixeles tomados 

a orientaciones diferentes),Solidez (relación de área por el área de su casco convexo, 

0-1 reporta cuan suave y convexo es el contorno del objeto) y Relación de Aspecto(AR, 

proporción entre ancho y altura de una imagen).(Yonis et al., 2020) 

(a)  (b)  

(c)  

I)  

II)  

Figura 30. Uso de Análisis de Partículas Extendido para análisis de casos. 

(a)Imagen 8bits, (b)Imagen con Threshold, (c)Menú de Análisis de Partículas 

Extendido: I) Resultados, II) Promedio de resultados 
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7.4.2.2. Análisis de color 

El análisis de color de frutos chilenos se llevará a cabo por medio del método de 

análisis de color por ImageJ (7.2.3.2). La imagen fue transformada de espacio RGB a 

CIELAB por medio del mismo programa (Image > Type > Lab Stack), opción que 

abrirá una ventana que cuenta con 3 vistas (L*, a*, b*). La posterior medición de color. 

se realizará por medio de la herramienta Polygon Selections (para piñón) y/o Oval 

para arándano, se traza el contorno del fruto y se eliminan las partes no deseadas con 

la misma herramienta (Alt+ Clic izquierdo). El trazo guardado en Resultados con la 

herramienta Measure (Analyze > Measure /Ctrl+ M) es posible identificar los valores 

promedio de 𝐿∗, 𝑎∗𝑦 𝑏∗ midiendo para cada uno de los valores, como se observan en 

la figura 24.b). 

 

7.4.3. Análisis De Textura  

7.4.3.1. Matriz de coocurrencia en escala de grises 

Para realizar el análisis de textura utilizaremos el plugin Textural features base in 

GLCM v04 (GLCM Texture). A cada imagen que se encontraba en formato RGB se le 

ajustó el contraste para posteriormente se convierta en 8bits (Image > Type > 8-bits) 

y se le seleccionó el área de interés con ROI desde un extremo al otro del fruto 

pasando por la parte media (Rectangle + click Izquierdo y arrastrar hasta el final), 

determinar las características de la textura superficial mediante la Matriz de ocurrencia 

en escaña de grises (Plugins > GLCM Texture). 

Mediante la realización de dicho análisis obtendremos los parámetros de energía 

(ASM, Angular Second Moment, medida de la homogeneidad local de la imagen), 

contraste (CON, medida de variación local del nivel de gris), Homogeneidad (IDMM, 

Inverse Difference Moment, medida de la diferencia de la intensidad de gris en pixeles 

vecinos) entropía (ENT, variable relacionada con el orden o desorden de la imagen y 

se relaciona con la textura de la imagen). 
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(a)  (b)  (c)  

(d)  

I) 

 

 

7.4.3.2. Dimensión fractal 

Se utilizó el Algoritmo Modificado de Conteo Diferencial de Cajas (SDBC, Shifting 

Differential Box Counting) para determinar los valores de la dimensión fractal de la 

textura de las imágenes, la que es posible utilizar para caracterizar la textura de las 

superficies y expresarla como una medida de la rugosidad o irregularidad que presenta 

la superficie de una imagen.(Baima & Ribotta, 2019). A cada imagen sin fondo que se 

encontraba en formato RGB se convirtió a 8bits (Image > Type > 8-bits), se seleccionó 

un área de 180x180 píxeles para generar un diagrama de Intensidad de superficie 

(Analyze > Surface Plot) el cual es generado a partir de los pixeles de la imagen en 

2D en escalas de grises (ejes x, y) y la intensidad de esta (eje z). El diagrama será 

cuantificado utilizado la dimensión fractal (Plugins > SDBC), la configuración del 

tamaño de las cajas se consideró como “automático” que es la opción entregada por 

el programa. El valor de la dimensión fractal de superficie (DFsup) se calculó mediante 

Figura 31. Uso de Textural features base in GLCM (GLCM Texture). 

(a)Imagen Original, (b)Imagen en 8bits, (c)Imagen con la sección a analizar 

señalada, (d)Menú de GLCM Texture: I) Resultados 
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la relación entre el logaritmo de número de cajas (N) y el logaritmo del tamaño de estas 

(1/r). Los valores de dimensión fractal oscilan entre 2 y 3. Las superficies lisas, sin 

rugosidad, presentan valores numéricos próximos a 2, mientras que las superficies 

altamente rugosas presentan un incremento en la dimensión fractal (Baima & Ribotta, 

2019) 

(a)  

(b)  

(c)  (I)  

Figura 32. Uso Algoritmo Modificado de Conteo Diferencial de Cajas (SDBC) 

para calcular DFsup. 

(a) Imagen en 8bits, (b)Imagen en binario, (c) Menú de SDBC: I) Diagrama de 

Fractales 

 

La dimensión fractal de contorno (DFcont) se evaluó utilizando el Conteo Diferencial de 

Cajas sobre imágenes de los contonros de los frutos, mientras más irregular el contono 

mayor será su DFcont. Las imágenes sin fondo fueron convertidas de RGB a 8Bits 

(Image > Type > 8-bits), posteriormente la imagen en binario (Process > Binary > 

Make Binary) y se calculó el contorno de la figura con (Analyze > Tools > Fractal 

Box Count), la configuración del tamaño de las cajas se consideró como “automático” 

que es la opción entregada por el programa. 
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(a)  (b)  

(c)  

I)  

II)  

 

 

7.5. ANÁLISIS ESTADÍSTICO 

Todos los análisis que fueron realizados se ejecutaron por triplicado y sus resultados 

fueron expresados como promedio ± análisis estadístico para las comparaciones de 

imágenes se realizará en el programa Statgraphics© para la realización de la prueba 

ANOVA (α=0,05). 

  

Figura 33. Uso Conteo Diferencial de Cajas (SDBC) para calcular DFcont. 

(a) Imagen en 8bits, (b)Imagen en binario, (c) Menú de Fractal Count Box: I) 

Resultados, II) Diagrama de Fractales 
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8. DESARROLLO Y DISCUSIÓN 

8.1. ESTADO DEL CONOCIMIENTO CIENTÍFICO 

8.1.1. Métrica de Publicaciones 

El procesamiento de imágenes digitales es el conjunto de técnicas que se aplican a 

las imágenes digitales con el objetivo de mejorar la calidad o facilitar la búsqueda de 

información, mientras que el análisis de imágenes se refiere a la extracción de 

información cuantitativa y cualitativa a través de una imagen(Dubey & Jalal, 2015). 

Considerando lo anterior, para la realización de la métrica de publicaciones se realizó 

la búsqueda el día 10 de diciembre del 2023 en WOS con las palabras clave “ImageJ” 

e “Image analysis”, se encontraron un total de 2340 publicaciones para la búsqueda. 

Siendo la primera publicación en el año 2003 con el uso del programa y existiendo un 

crecimiento lento pero sostenido hasta el año 2014, posterior a esta fecha existió un 

aumento de la generación de conocimiento en el área de análisis de imágenes ya que 

se registran más de 100 publicaciones anuales, obteniéndose la mayor cantidad de 

publicaciones por año en el 2023 siendo 275 publicaciones en dicho año. 
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Figura 34.  Gráfica de total de publicaciones y su frecuencia acumulada por año. 
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Cabe destacar que a partir del año 2020 existió un crecimiento de 10% de 

publicaciones anuales, este incremento en el número de publicaciones puede ser 

atribuible a las mejoras en las tecnologías y al crecimiento en el uso de herramientas 

digitales en los campos de las ciencias y el acercamiento de estas a los 

establecimientos educacionales, motivando la investigación y el .desarrollo de 

conocimientos.(Martín Vilches et al., n.d.; Rueden et al., 2017) Ya que para el año 2024 

se proyectan hasta el momento 278 publicaciones el área, siendo la mayor cantidad 

de publicaciones hasta el momento con un 12% de las publicaciones totales para este 

año.  

 

8.1.1.1. Tipo de documentos 

En el universo de publicaciones observa que el tipo de publicaciones realizadas fueron 

en su mayoría artículos de investigación obteniendo el 96% de las publicaciones,1,5% 

de publicaciones de acceso temprano 1,0% en revisiones, 0,2% en ponencias y 

capítulos de libros. Demostrando que la mayor generación de conocimiento es en la 

investigación científica. 

 

8.1.1.2. Países  

Con respecto al desarrollo de estos conocimientos, Estados Unidos es el líder mundial 

en el desarrollo de publicaciones en el uso de ImageJ y procesamiento con análisis de 

imágenes con 610 publicaciones (19,2% del total), seguido por Alemania e Inglaterra 

con 219 y 177 publicaciones respectivamente. En la figura 35, se puede observar la 

relación de número de publicaciones científicas por país, destacando los países que 

tienen al menos 5 publicaciones en procesamiento de imágenes e ImageJ. 
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Entre los países latinos Brasil posee el mayor número de publicaciones con 153 

publicaciones, quinta posición de publicaciones a nivel mundial, representando una 

gran potencia no sólo regional en esta área de conocimientos; México ocupa el 

segundo lugar regional con 26 publicaciones, seguido de Chile y Colombia en tercer 

lugar con 10 publicaciones cada uno, lo que propone un nuevo campo de conocimiento 

a potenciar ya que la existencia y la posibilidad de crecimiento regional es posible. 

 

8.1.1.3. Categorías 

En el ámbito de las categorías de publicación que fueron exploradas en el análisis de 

las publicaciones analizadas, la categoría de Ciencias y Tecnología de Alimentos 

(Food Science Tecnology) no ha tenido mucha representación como se observa en la 

figura 36, ya que ocupa el vigésimo séptimo lugar con un 1,7% del total de 

publicaciones, mientas que las ciencias multidisciplinarias (Multidisciplinary Science) 

que es la categoría con mayor presencia ocupa el 9,4%.La predisposición de la 

investigación en las ciencias de la salud, así como química y biología se puede atribuir 

(González, 2018; Schroeder et al., 2021) a la presencia de los programas Fiji y 

ImageJ2 que están específicamente destinados a usos de análisis específicos en estas 

áreas (Rueden et al., 2017; Schindelin et al., 2012).  

Figura 35.  Representación de publicaciones científicas por país.  
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Considerando lo anterior, podemos atribuir que el procesamiento de imágenes es una 

categoría moderna y de crecimiento en el área de la ciencia, al igual que avanza según 

se mejoran las tecnologías y el acceso a las mismas por partes de las personas. 

Considerando este avance y mejora continua, programas como el ImageJ y sus 

derivados, son de gran importancia para la evolución de las ciencias digitales. 

 

8.1.2. Métrica de citas 

Con respecto al uso de los conocimientos generados, la métrica de citas demuestra 

un incremento sustancial del uso citas desde el año 2012 al 2021(16% de las citas 

totales), mientras que existió un ligero decrecimiento en las citas entre 2022 y 2023 

con un 15,8% y 13,7% respectivamente, igualmente se utilizan más de 17000 

citaciones en el tema de análisis de imágenes que no han decrecido desde el 2020. 

En la figura 37 se aprecia que según aumentan las publicaciones, aumentan las citas 

relacionadas con las publicaciones llegando a su máximo de citas en el 2021, 

obteniendo 20538 citas para las 275 publicaciones realizadas en dicho año. 
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Se puede observar que a partir del año 2010 se presenta un crecimiento lineal (r2 de 

0,94) para las citaciones realizadas, obteniendo obre un 20% de tasa de crecimiento 

para cada año. Este crecimiento lineal de la métrica de citas es concordante con el 

incremento de publicaciones y se espera, considerando el aumento en el número se 

publicaciones que siga con su crecimiento lineal. 

Con respecto a las publicaciones más influyentes, se pueden observar en la Tabla 1. 

donde se presentan las tres publicaciones más citadas. La publicación más citada es: 

“NIH Image to ImageJ:25 years of image analysis” de Schindelin en el 2012 ocupando 

el 39% de las citas para la categoría buscada. Este artículo posee la característica que 

explica a profundidad los inicios de la herramienta desde la necesidad de la existencia 

de un software de análisis de imágenes para Mac y su migración a los otros sistemas 

operativos en forma de ImageJ (formato Java), sus descendientes (Fiji y de ImageJ2) 

y futuras aplicaciones. Informando cómo ha crecido en sus características a través del 

desarrollo e implementación de la misma comunidad a través de plugins, las 

dificultades que abarca el formato tan simple del software, como fue el aceptar todos 

los tipos de formatos de imágenes para su análisis y la conectividad con otros 
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programas que permitan la migración de su información de una manera práctica, como 

es el Imaris, Cell Profiler y Knime. 

 

Tabla 1. Publicaciones más relevantes según las citas totales realizadas 

Publicación Autor Citas Totales 

NIH Image to ImageJ:25 years of 

image analysis 
(Schneider et al., 2012) 38900 

Fiji: an open-source platform for 

biological-image analysis 
(Schindelin et al., 2012) 34602 

ImageJ2: ImageJ for the next 

generation of scientific image data 
(Rueden et al., 2017a) 3562 

 

El segundo y tercer artículo con mayor influencia presentan características similares al 

ser análisis profundos a las herramientas Fiji e ImageJ2, las cuales como ya se ha 

señalado son sucesoras de ImageJ enfocadas en un ambiente más biomédico El 

artículo de Schindelin realiza una visión retrospectiva de Fiji, destacando su uso 

enfocado en el mundo de la imagen biología y que como herramienta posee amplias 

librerías de softwares que mayor potencia y utilización que su antecesor, pero 

destacando la característica de transformar cualquier algoritmo, que sean generados 

para este software, transformarlo a ImageJ como plugins permitiendo así el 

crecimiento continuo de este último, permitiendo así el crecimiento continuo del 

programa e interacción entre ellos. El artículo de Rueden destaca la gran demanda 

que existía por el ámbito de la biología por la herramienta ImageJ, generando un gran 

crecimiento de plugins una amplia demanda, y como ellos dieron pie siguiente paso 

para dar abasto al continuo crecimiento, desarrollaron ImageJ2, un completo rediseño 

de su antecesor al ser una herramienta más robusta, con una arquitectura mejorada 

que debiera acompañar sin problema a las demandas científicas de las próximas 

décadas proyectadas. Cabe destacar que el segundo y tercer artículo más citados han 

tenido entre sus autores al doctor Johannes Schindelin, cuyas categorías de 
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investigación son ciencias y tecnologías, matemáticas y biología computacional, 

biotecnología y microbiología aplicada, lo que ya destaca que existen investigadores 

dispuestos a enfocarse en el área de investigación científica computacional. 

La realidad nacional de las 10 publicaciones realizadas en el área, la más citada es la 

primera publicación “Study on image análisis application for identification Quinoa seeds 

(Chenopodium quinoa Willd) geographical provenance”, donde se realizaron 

mediciones geométricas, características morfológicas, dimensiones de fractales y 

análisis de color en 28 variedades de Quinoa aplicando el software ImageJ para su 

realización (Medina et al., 2010). En dicho artículo destacan la importancia del 

mercado global y el lugar de origen de los productos, destacando la importancia que 

esta posee sobre la calidad de los productos, los procesamiento de satirización y al 

regulación en los mismos, proponiendo el uso de ImageJ como herramienta para medir 

estos parámetros desde un punto de vista computacional y de varias muestras al 

mismo tiempo, permitiendo identificar efectivamente las regiones de origen del 

producto (en este caso quinoa) a partir de sus características morfológicas y color. La 

publicación sigue señalando la utilización del análisis de imágenes como herramienta 

de control de calidad de productos y que pueden generar un posible impacto en la 

agricultura e ingeniería de alimentos ya que son métodos que pueden ser atribuibles 

a productos similares, en este caso específico cereales.  

 

 

8.2. ANÁLISIS DE IMÁGENES 

8.2.1. Recuento y predicción de semillas  

8.2.1.1. Semillas de zapallo 

Los resultados obtenidos demuestran que en el conteo una a una se observan como 

resultado 36 semillas, mientras que con la predicción se obtienen 38 ± 3 semillas. 

Por su contraparte la imagen no estandarizada de las semillas (figura 38.a), se tomó 

la misma muestra, pero fue fotografiada y registrada a luz artificial ambiental. Por 
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medio de la aplicación del 8 bit, se observar el “ruido” presente en la fotografía lo que 

genera que se deba realizar una limpieza del borde la misma foto (figura 38.b y figura 

87.c) para poder posteriormente realizar el recuento por medio del análisis de 

partículas. 

(a)  (b)  

(c)  (d)  

 

En esta oportunidad obtenemos un conteo de 50 ± 20,1 semillas, debido a las 

imperfecciones presentes con la definición del contorno de las semillas. En la figura 39 

se observan los bordes de las semillas, donde se presentan unas pequeñas 

estructuras, las cuales son contabilizadas por el programa, impidiendo tener una 

precisión más certera a la imagen estandarizada y genera el exceso en la predicción. 

Figura 38.  Fotografía de 6 gramos de semillas de zapallo.  

(a)Imagen original, (b)Imagen en 8Bits con aplicación de Thershold, (c)Limpieza de 

fondo y preparación para análisis, (d)Recuento con análisis de partículas. 
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8.2.1.2. Semillas de maravilla 

Se puede observar que el recuento manual da como resultado 186 semillas de 

maravilla, mientras que el recuento de partículas da como resultado 293,7 ± 110,3 

unidades. Al igual que con el caso anterior, la diferencia es atribuible a la formación de 

pequeñas partículas a partir de la imagen original al general el traspaso a 8bit, lo que 

da como resultado una sobrevaloración de las semillas. 

En esta oportunidad, debido al tamaño presente en la semilla de maravilla, a pesar de 

poseer la imagen estandarizada para el análisis, se puede observar el mismo problema 

de definición, al aglutinarse entre ellas (Fig.39.b), y con la herramienta división 

(Watersheld) separar las estructuras que se fueron uniendo. 

(a)  (b)  (c)  

Figura 39.  Aplicación de Análisis de partículas en microestructuras de las 

semillas 

Figura 40. Escáner de 4 gramos de maravilla  

(a)Imagen original, (b)Análisis de partículas, (c)Conteo manual. 
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A la imagen no estandarizada, al igual que el caso anterior se debió realizar una 

limpieza de fondo para posteriormente realizar el recuento de partículas. En esta 

oportunidad se obtuvieron 319,3 ± 90,7 unidades con el recuento de partículas, número 

que es considerablemente superior al número estandarizado y que claramente está 

alejado que la cantidad original de semillas, nuevamente esta discrepancia puede ser 

atribuible al reconocimiento y definición de la imagen por el programa. Al ser una 

imagen no estandarizada, las diferencias en la coloración (fondo, semilla) y la 

sobrevaloración de partículas afectan de manera negativa el conteo de la imagen. 

(a)  (b)  (c)  

 

8.2.1.3. Semillas de sésamo 

En la figura 42.a podemos observar el análisis de semillas se sésamo por medio del 

análisis de partículas obteniendo 833,3 ± 52,6, mientras que el recuento manual dio 

758 semillas, lo cual se aprecia una buena aproximación (menor desviación entre ellas) 

a pesar del diminuto tamaño y poseer algunas semillas unidas. 

Figura 41. Fotografía de 6 gramos de semillas de maravilla.  

(a)Imagen Original, (b)Imagen en 8Bits con aplicación de Thershold, (c)Recuento 

con Análisis de partículas. 
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(a)  (b)  

 

Con la imagen no estandarizada, al igual que en las ocasiones anteriores presentó 

ruido en la muestra, la cual fue removida para la predicción. Obteniéndose en esta 

ocasión 804±39 semillas predichas por el programa. En ambos casos, se puede 

observar la gran presencia de sobreestimación de semillas debido a la sobre posición 

de la muestra o a la falta de definición de los pixeles en el caso de la imagen no 

estandarizada. 

(a)  (b)  (c)  

En la tabla 2, se presenta el resumen y comparación de las semillas con respecto al 

recuento manual y los valores obtenidos del recuento automático de las imágenes 

estandarizadas y no estandarizadas por medio del programa ImageJ. 

Figura 42. Semillas de sésamo contabilizadas  

(a)Análisis de partículas, (b)Conteo manual. 

Figura 43. Fotografía de 2 gramos de semillas de sésamo.  

(a)Imagen Original, (b)Imagen en 8Bits con aplicación de Thershold, (c)Recuento 

con Análisis de partículas. 
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Si bien se observa diferencias entre los valores obtenidos entre el recuento manual y 

automático, no se observan diferencias significativas entre el recuento manual y el 

automático con imagen estandarizada y no estandarizada para las muestras de 

semillas de zapallo y sésamo obteniendo grupos homogéneos en ambos casos. 

 

Tabla 2. Comparación de recuento de semillas 

Semilla Manual 

 (unidades) 

Escáner (unidades) Fotografía  

(unidades) 

Zapallo 36a 38,3 ± 2,3a 59,0 ± 20,1a 

Maravilla 186b 293,7 ± 110,3c 319,3± 90,7c 

Sésamo 758d 833,3 ± 52,6d 804,0 ± 39,4d 

Los valores representan X±SD. a-d Letras iguales demuestran que no existen diferencias significativas (p < 0,05) entre el 

recuento de semillas. 

 

En el caso de la semilla de maravilla si se observa una diferencia entre el recuento 

manual y el automático, pero no se observan diferencias entre el conteo estandarizado 

y no estandarizado, podemos atribuir como razón de la sobrevaloración de unidades, 

a la distribución de la semilla (en más contacto entre ellas), o al color irregular entre 

las semillas, lo que genera una estructura menos uniforme para analizar y se generan 

los manchones que al separarse con las herramientas no quedan perfectamente el 

número original de las semillas generado un sobre participaron de la imagen y por lo 

tanto una sobre valoración de unidades, que generaría la homogeneidad entre el 

recuento automático, pero la diferencia significativa con el recuento manual en el caso 

de esta semilla. A pesar de la diferencia de la semilla de maravilla, podemos asegurar 

que el desempeño de la herramienta “recuento de partículas de ImageJ” si es efectiva 

para el cuento de semillas tanto para imágenes capturadas por un escáner (contacto 

directo) como para una cámara digital. 
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8.2.2. Análisis de tamaño 

Para el análisis de tamaño se contó con 3 muestras de tomates Cherries, los resultados 

de la medición fueron los presentados en la Tabla 3. Si bien no existieron dificultades 

en la captura y análisis del software, ya que sólo necesita la definición de la escala 

(Set Scale) y posterior herramienta Linea (Straigh), si se presentan diferencias 

significativas entre la medición en vivo de la muestra y la imagen capturada con la 

cámara. 

 

Tabla 3 Comparación de tamaño (cm) por análisis de imagen  

 Fruto Cámara Oscura Fotografía 

Muestra Alto Ancho Largo Alto Ancho Largo Alto Ancho Largo 

Tomate 

1 
2,8 3,1 3,0 2,66±0,08 3,14±0,08 2,88±0,08 3,23±0,14 3,30±0,44 2,56±0,13 

Tomate 

2 
2,7 2,9 2,7 2,71±0,09 2,93±0,16 2,61±0,07 2,95±0,32 2,89±0,31 2,95±0,07 

Tomate 

3 
2,7 2,7 2,6 2,69±0,08 3,14±0,08C 2,89±0,09 3,29±0,07 3,34±0,43 2,67±0,20 

Los valores representan X±SD 

 

En el caso de la medición de largo, ancho y alto, se pueden observar diferencias 

significativas entre las imágenes estandarizadas y no estandarizadas. Para cada una 

de la medición no existió diferencia entre los valores de la muestra original y las 

capturadas en la cámara obscura, pero sí existieron diferencias entre las capturadas 

directamente en el ambiente, lo cual demostraría la necesidad de la estandarización 

para la posibilidad de reproducción entre las imágenes. 
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a-d Letras iguales demuestran que no existen diferencias significativas (p < 0,05) para la misma muestra con diferente método 

de medición 
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8.2.3. Análisis de color  

Los resultados obtenidos del análisis de color a las frutillas se pueden observar en la 

Tabla 4. Donde podemos observar la comparación del color promedio de cada imagen 

demostrando sus valores L*, a*, b* promedio y su representación total en la escala de 

color.  

 

Tabla 4. Comparación del color por análisis de imágenes 

 Imagen Promedio ImageJ Color promedio Photoshop 

Muestra L* a* b* Color L* a* b* Color 

Frutilla 1 57 43 46  55 52 48  

Frutilla 1* 30 27 20  29 30 24  

Frutilla 2 63 36 35  54 48 41  

Frutilla 2* 32 42 28  34 34 27  

Frutilla 3 63 37 30  52 41 36  

Frutilla 3* 35 32 26  36 36 28  

*Fotografías no estandarizada/. Los valores representan X 

 

Si bien se observa una diferencia visual entre la muestra estandarizada y la no 

estandarizada en su saturación y luminosidad (L*) se puede observar que no existe 

diferencias significativas para para las imágenes no estandarizadas en ninguno de los 

programas analizados, obteniéndose los valores de 32 ± 2,3 para los valores promedio 

analizados por ImageJ y 33 ± 3,8 para los valores promedio analizados por Photoshop. 

Situación que se repite para las imágenes de la muestra 1 (Frutilla 1) estandarizada, 

donde no se observan diferencias significativas entre sus muestras al obtener 57 ± 2,3 

en el análisis por ImageJ y de 55 ± 4,3 en el análisis por Photoshop. Lo contrario ocurrió 

con las muestras de las frutillas 2 y 3 sí presentan diferencias en su luminosidad por 
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cada programa analizado, obteniéndose de 63 ± 4,1, 54 ±5,2 y 63 ± 4,9, 52 ± 9,2 en 

ImageJ y Photoshop respectivamente. 

 

*Fotografías no estandarizadas. A y B letras iguales demuestran que no existen diferencias significativas (p < 0,05) dentro de 

la misma muestra para diferente programa / a-c Letras iguales demuestran que no existen diferencias significativas (p < 0,05) 

entre las diferentes muestras. 

 

La homogeneidad en la luminosidad de las muestras no estandarizadas se puede 

deber a la falta de iluminación directa sobre el fruto, ya que fue tomada la fotografía en 

condiciones estándar de laboratorio y al no ser un ambiente controlado, ocurrió las 

mismas condiciones sobre los frutos, obteniéndose valores similares entres sus 

muestras, razón por la cual también es atribuible la luminosidad similar entre ellas a 

pesar de ser frutas diferentes de la misma especie. Un ejemplo de un cálculo 

representativo de buena iluminación y similitud en los resultados si se pudo apreciar 

con la con la muestra 1 la cual obtuvo valores similares entre sus análisis por ambos 

programas. En contraparte a la diferencia en la luminosidad de las muestras 2 y 3 (que 

si contaban con una iluminación controlada) puede ser atribuible al software Photoshop 

que automáticamente selecciono los colores similares presentes en el fruto para su 

cálculo, a diferencia del ImageJ donde un manipulador descarta de manera selectiva 
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las partes con más brillo, manchas u sombra del fruto, proceso que tomó más tiempo 

pero permitió una mayor similitud entre los valores obtenidos de sus imágenes debido 

a la segmentación manual. 

 

*Fotografías no estandarizadas. A y B letras iguales demuestran que no existen diferencias significativas (p < 0,05) dentro de 

la misma muestra con diferente programa / a-c Letras iguales demuestran que no existen diferencias significativas (p < 0,05) 

entre las diferentes muestras. 

 

La coloración verdosa-rojiza (a*) presentó un comportamiento similar al parámetro 

anterior, no presentaron diferencias significativas en las muestras a excepción de la 

Muestra 1 (estandarizada y no estandarizada) y 2 estandarizadas. Obteniéndose, en 

27 ± 1,4 para la muestra 1 no estandarizada y en promedio 33 ± 7,5 y 33 ± 3,4 para 

las muestras de ImageJ y Photoshop en las muestras no estandarizadas. En el caso 

de las muestras 1 y 2 dicha diferencia en la coloración de las muestras estandarizadas 

atribuibles a la condición estandarizada de la muestra, al poseer una mejor iluminación 

se pueden observar a más detalle las imperfecciones del fruto, permitiendo que el 

software ingrese una mayor cantidad de sombras u de coloración verdosa a la muestra 
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*Fotografías no estandarizadas. A y B letras iguales demuestran que no existen diferencias significativas (p < 0,05) dentro de 

la misma muestra con diferente programa / a-f Letras iguales demuestran que no existen diferencias significativas (p < 0,05) 

entre las diferentes muestras. 

 

La coloración azulino-amarillenta (b*) no presentó diferencias significativas entre las 

muestras analizadas estandarizadas analizadas por ImageJ y Photoshop obteniendo 

en promedio de 37 ± 8,0 y  42 ± 6,0 respectivamente, en el caso de las muestras no 

estandarizadas en pero si se obtuvieron diferencias entre las muestras obteniéndose 

25 ± 4,2 de promedio entre ellas, es importante destacar que si bien muestra1 no 

estandarizada (Frutilla 1*),posee una diferencia entre los resultados encontrados por 

los diferentes softwares de análisis. Esta diferencia puede ser similar al caso de la 

luminosidad, al ser el programa un recuento automático, puede considerar partes no 

deseadas para la selección del color. 

En la rueda de color de la figura 48 se puede apreciar la diferencia de saturación 

obtenidas por los programas y la ubicación del valor obtenida en las muestras, si bien 

los valores se encuentran en un cuadrante relativamente similar, lo cual es esperable 

al ser frutas de la misma especie, compradas en la misma ubicación y de la misma 

cosecha se puede apreciar cómo la opacidad aumenta de forma significativa en las 

muestras no estandarizadas, debido a la misma falta de iluminación. Así mismo se 
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nota la diferencia en la opacidad entre el software ImageJ y Photoshop, lo cual 

concuerda con lo encontrado en otros estudios (Césari Matilde et al., 2020) 

(a)  (b)  

(c)  (d)  

 

Considerando los resultados obtenidos, podemos asegurar que el programa ImageJ si 

es aplicable para la identificación acertada del color de una muestra, pero se 

recomienda mantener unas condiciones controlada, ya que si bien se obtendrán 

valores concordantes para en condiciones no controladas de medición, se nota una 

falta de brillo en la muestra y se podría apreciar un registro erróneo de la calidad del 

alimento, pero no se descarta la utilidad del uso de la captura de imágenes (por cámara 

digital o celular de buena resolución) de la muestra ya que sí puede implementarse 

para la determinación de características físicas de calidad en muestras de alimentos y 

permitirá llevar un registro claro y reproducible de las muestras. 

Figura 48. Rueda de color con resultados promedio de análisis de color para 

frutilla. 

(a)ImageJ estandariza, (b)ImageJ no estandarizada, (c)Photoshop estandarizado, 

(d)Photoshop no estandarizado. 



70 

8.2.4. Análisis de imágenes de difusión científica 

8.2.4.1. Emulsiones 

Los resultados para el tamaño de gota original se presentan en la figura 49.a donde 

se determinó la distribución de las emulsiones después de 20 días. Después de los 20 

días, el tamaño de las partículas aumento significativamente, entre en todas las 

muestras. 

 (a)  

(b)  
A y B letras iguales demuestran que no existen diferencias significativas (p < 0,05) de tamaño dentro de la misma muestra / a-

e Letras iguales demuestran que no existen diferencias significativas (p < 0,05) entre las diferentes muestras para la misma 

emulsión en el mismo tiempo de almacenamiento. 
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Mientras que en el análisis realizado (figura 49.b) se puede apreciar que no existieron 

diferencias significativas entre la misma muestra a diferente tiempo de 

almacenamiento. Según la publicación se caracterizó a la muestra 5:3-50 (relación 

zeína: pectina-MYT) como la estructura optima de la estabilización los diámetros 

obtenidos para esta muestra fueron 40,76 ± 6,66 el día inicial y 44,74 ± 6,70 

demostrando un pequeño crecimiento en la perdida de esfericidad de la molécula, 

mientras que en el análisis 40,36 ± 20,1 el día inicial y 43,69 ± 19,02. Se puede apreciar 

que no existen diferencias significativas entre los promedios obtenidos, pero sí son 

apreciable en sus dispersiones, lo cual puede ser atribuible a la repetición del análisis 

de la misma imagen, mientras que en el artículo original se pudieron analizar diversas 

muestras demostrando una mejor homogeneidad entre ellas.  

Por lo tanto, ImageJ si es un abuena herramienta para el análisis de emulsiones, 

permitiendo calcular el diámetro de partículas sin mayor dificultad, pero se recomienda 

utilizar diversas muestras y un buen procesamiento de la imagen (arreglo de color en 

caso de ser necesario) para obtener una mejor caracterización de las muestras. 

 

8.2.4.2. Unidades formadoras de colonias 

El estudio original fue realizado por 13 participantes a los cuales se les entregó las 

imágenes y se les entregó las indicaciones de cómo realizar el análisis en las 

imágenes, que consisten en diversas muestras de cultivo de flores de Marihuana y 

cepas del hongo Candida Albicans (C. Albicans, presente en el cultivo de Cannabis. 

Las fotografías fueron tomadas por medio de un celular (iPhone) y se obtuvieron los 

valores señalados en la Figura 50, donde se comparan los valores obtenidos por Stolze 

junto con los analizados para este estudio, los resultamos demostraron que, si existía 

diferencia significativa entre el conteo automático y manual de las muestras, pero dicho 

error se puede atribuir a un error humano y no a un error del método, a pesar de ello 

los participantes identificaron la herramienta como de fácil aprendizaje(Stolze et al., 

2019).  
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(a)  

(b)  

a-i Letras iguales demuestran que no existen diferencias significativas (p < 0,05) entre las diferentes muestras a distinta 

dilución. 

 

Mediante el análisis de imágenes se observar que no existieron diferencias 

significativas entre los resultados obtenidos por Stolze y el realizado en este estudio, 

lo cual señala una de las principales hipótesis que es la reproducción efectiva de los 

mismos análisis por diferentes participantes. Obteniendo tantos valores similares entre 
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el recuento manual y el realizado con el análisis de partículas de ImageJ, si bien se 

obtuvieron valores con menores deviaciones en este análisis se puede deber al mismo 

error humano que se señaló anteriormente, ya que al poseer una mayor cantidad de 

personas analizando la misma imagen, pueden generar una mayor desviación entre 

ellas.  

(a)  

(b)  

 

Paralelamente, si realizamos una calibración entre el conteo automático y el conteo 

manual, podemos observar que existe una correlación lineal (Correa et al., 2020) entre 

ambos conteos. La regresión se observa que el coeficiente de regresión (R2) de 0,98 

y = 1,0621x - 4,6056
R² = 0,9872
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para el análisis del teórico y 0,99 para el análisis de datos (Figura 51)Como se puede 

observar existe una correlación lineal entre los datos observados y una buena 

predicción del valor manual a partir del valor automático, lo que indicaría que el uso de 

herramientas de análisis como el ImageJ podría ser de utilidad para la industria de los 

alimentos permitiendo no sólo realizar los recuentos de manera digital y de manera 

mucho más expedita, permitiendo llevar un registro electrónico de los cultivos por 

medio de imágenes digitales permitiendo la posibilidad de acceder a los datos o 

recrearlos de ser necesario. 

 

 

8.3. VALIDACIÓN DEL INSTRUCTIVO “USO DE IMAGEJ” 

8.3.1. Análisis Cuantitativo 

A los 14 participantes encuestados se les entregó la encuesta donde se expresaba 

que se necesitaba analizar y se le facilitó el instructivo de “Uso de ImageJ”, para 

observar cómo se desarrolló la cualitativamente los valores obtenidos se realizará una 

comparación con los valores esperables o valores obtenidos del análisis realizado para 

la comparación. Los valores obtenidos por los encuestados para el análisis de color 

(frutilla) se recolectaron y se compararon con el valor del análisis de color se 

encuentran disponibles en la tabla 5, donde se observan las variaciones para la escala 

CIELAB. 

 

Tabla 5. Comparación del análisis de color (CIELAB) obtenidos en la encuesta. 

Variable Análisis de color (Obtenido) Análisis de color (Encuesta) 

L* 60,98 ± 0,19a 58,16 ± 9,16b 

a* 43,33 ± 0,03a 35,64 ± 19,32b 

b* 35,12 ± 0,19a 25,24 ± 9,09b 

Los valores representan X±SD. a y b Letras iguales demuestran que no existen diferencias significativas (p < 0,05) para el 

fruto por los análisis realizados. 
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Se puede apreciar que existen diferencias significativas para ambos análisis, para los 

valores L*, a* y b*. Esto puede ser atribuible a la diferencia de elección de área del 

fruto a analizar, cuando se les consultó a los encuestados cómo consideraron el 

espacio de evaluación, algunos señalaron que consideraron las hojas del fruto, lo cual 

afectaría a la segmentación de la fruta y por ende se explicaría el cambio en los valores 

que presenta un menor brillo (L*), y la coloración más destinada al verde (a*) y al azul 

(b*) como se observa en la figura 52. 

 

T corresponde al color teórico, E corresponde al valor obtenido por los encuestados. 

 

Si bien en la encuesta se solicitaba considerar el color del fruto, se admite que se debió 

considerar expresar la necesidad de excluir las hojas del fruto, y dejar sólo la pulpa 

comestible para su análisis. Así mismo, la libertad de elección de puntos utilizados 

para la elección pudo afectar el color final, ya que algunos encuestados comentaron 

utilizar varios puntos para cubrir bien el área del fruto y otros utilizaron menos 

abarcando la misma área con menos rigurosidad, lo cual también podría demostrar la 

diferencia en la coloración del fruto.  

Los resultados obtenidos por los encuestados para el recuento de semillas se 

encuentran presentados en la figura 53. En la imagen a analizar se presentaba una 

mezcla de semillas en la imagen, se pudo obtener diferencias significativas entre el 

número total de semillas (131 unidades), el valor del recuento automático que fueron 

Figura 52. Rueda de color con resultados promedio de análisis de color para 

frutilla.  

T 

E 
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152,33±9,29 y el valor del recuento obtenido por los encuestados que fue 

280,75±122,16. Considerando lo observado y comentado por los mismos encuestados 

el uso de las herramientas Threshold, herramienta necesaria para realizar el análisis, 

fue al que presentó la mayor dificultad. Considerando lo anterior, es considerable 

adicional la explicación del uso correcto de la herramienta. 

 

a-c Letras iguales demuestran que no existen diferencias significativas (p < 0,05) entre el recuento y el total de semillas. 

 

Así mismo, el recuento de unidades formadoras de UFC (figura 54) demostró 

diferencias significativas entre el valor obtenido y el recuento de la encuesta, si bien la 

actividad fue realizada con conteo uno a uno de las UFC, la diferencia puede ser 

atribuible a la sobreestimación por parte de algunos de los encuestados y a la 

uniformidad de parte del analizador al evaluar la imagen, ya que al realizar la misma 

persona tres veces el ejercicio. 
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a y b Letras iguales demuestran que no existen diferencias significativas (p < 0,05) entre los recuentos realizados. 

 

Todos los encuestados señalaron que el conteo manual de UFC es mucho más fácil 

que la predicción por medio del análisis de partículas, pero concuerdan que, con una 

mayor cantidad de UFC, la predicción sería de mucha ayuda y un ahorro de tiempo en 

el conteo de unidades. 

 

8.3.2. Análisis Cualitativo 

8.3.2.1. Evaluación de instalación 

De los 14 participantes encuestados, 100% señalaron poder instalar el programa 

ImageJ sin problemas en el sistema operativo Windows, directamente desde el enlace 

entregado en el instructivo. Resultados que están dentro de lo esperado, considerando 

la adaptabilidad del software a los distintos sistemas operativos.  
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8.3.2.2. Evaluación de casos 

8.3.2.2.1. Análisis de color 

En las evaluaciones de Análisis de color, de la escala de 1(nada difícil) a 5 (muy difícil) 

¿Qué tan dificultoso fue medir el color de la fruta 50% de los encuestados señalaron 

que fue nada difícil realizar la evaluación. Mientras que un 50% dio que era 

normalmente difícil realizar la evaluación. Cabe señalar que, si bien la actividad no 

presentaba mayor dificultad al solicitar el software con un análisis RGB, si demostraron 

dificultades al no existir una herramienta automática que realizara el análisis, lo que 

para el 50% significo informar que fue normalmente difícil la actividad. 

 

8.3.2.2.2. Recuento de semillas 

Análisis de semillas, de la escala 1(nada difícil) a 5 (muy difícil) ¿Qué tan difícil fue 

realizar el recuento? Un 50% de los encuestados señaló que fue normalmente difícil 

realizar el recuento de las diversas semillas mientras, 25% señalo que fue algo difícil 

y el 25% restante señaló que fue muy difícil desarrollar la experiencia.  

Para la realización del análisis, se mezclaron diversos tipos de semilla para agregar 

dificultad en la actividad ya que se debía realizar el recuento automático para estas, la 

actividad se pudo llevar a cabo sin mayores inconvenientes por los encuestados, los 

cuales señalaron que la mayor dificultad presente fue la inexperiencia en la aplicación 

de filtros en la imagen para aplicar bien la predicción. Así mismo señalaron que le 

apreciarían una mejor explicación de los parámetros presentes en el análisis de 

partículas. 

 

8.3.2.2.3. Recuento de UFC. 

Análisis de UFC, de la escala 1(nada difícil) a 5 (muy difícil) ¿Qué tan difícil fue realizar 

el recuento? Un 100% de los encuestados señaló que no fue nada difícil realizar el 

conteo manual de las UFC con el software, debido a la baja cantidad de colonias 

presente en la imagen, los encuestados reconocieron que el conteo manual fue rápido 
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y eficiente, pero reconocen que con un mayor número de unidades la aplicación 

automática sería de mayor utilidad. Finalmente, en todos los análisis realizados un 

80% señaló que se guardaron sus datos a Excel sin dificultad al terminar la experiencia, 

el 20% restante señaló que le parece inconveniente el deber “separar los datos” y que 

no vengan ya listos para su trabajo. 

 

8.3.2.2.4. Retroalimentación 

Con respecto a la comprensión del instructivo se comentó que fue de fácil compresión 

y que al ser bastante descriptivo permite guiarse en el paso a paso de los ejercicios 

sin dificultad. A pesar de lo, se recomendó señalar de mejor manera los clics dentro 

del mismo con la finalidad de hacer aún más evidente las herramientas a utilizar. 

(a)  

(b)  

 

Otras mejoras propuestas, fue una mejor explicación de cómo se cambian los 

parámetros, así mismo explicar el cómo se visualiza las diferentes escalas en las que 

se están midiendo, ya que en casos como el CIELAB se abren 3 ventanas diferentes 

y no se contaba con una explicación certera en el manual explicando el porqué, el 

nuevo anexo de utilización de escalas para herramientas disponible en el nuevo 

“Anexo 3 del “Instructivo de uso de ImageJ”” Con respecto a la apreciación del 

programa se señaló que, si bien es útil y fácil de utilizar, su interfaz es anticuada y 

poco atractiva debido a la antigüedad y simpleza del software. 

Figura 55. Mejoras realizadas al instructivo. 

(a)Antigua barra de herramientas, (b)Nueva barra de herramientas con la 

demarcación.  
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8.4. ANÁLISIS DE CASOS 

8.4.1. Análisis de piñón 

8.4.1.1. Análisis morfométrico y color 

Los valores promedio del análisis morfométrico y color para piñón son presentados en 

la figura 56. Observamos que las dimensiones de área y perímetro del piñón fueron de 

7,81 ± 2,1 cm2 y de 14,69 ± 2,12 cm respectivamente, mientras que el largo del piñón 

(5,95 ± 0,74) son mayores a la talla promedio (3,5 - 4,5cm), estas características 

demuestran que es un fruto de gran tamaño lo cual puede ser atribuible al crecimiento 

de los frutos ya que, en tiempos de buen clima, al ser un fruto natural y silvestre puede 

alcanzar los 6cm o más, por lo cual nos podríamos encontrar frente un fruto de un buen 

año de crecimiento. (Fundación para la Innovación Agraria, 2010).Mientras que la 

relación de AR (3,39 ± 0,47) significa que la figura es más larga que alta, lo cual es 

concordante con las características esperables del fruto. 

La circularidad del fruto es 0,45 ± 0,05, lo cual nos da una circularidad media acorde 

con la forma corniforme (forma de cuerno) del fruto, presentando una apariencia más 

ovalada en que circular. La solidez, que es un parámetro que es un parámetro que va 

de 0 a 1 y hace referencia a cuan “suave/liso” y convexo es el contorno del objeto, 

mientras más cercano a 0 más cavidades o menor solidez tendrá, mientras que una 

estructura perfectamente convexa poseerá un valor 1(Yonis et al., 2020), se demuestra 

que el piñón (0,966 ±0.01) es una estructura bastante convexa en contorno, sin 

presentar mayores imperfecciones. 

El color de la cubierta externa de la araucaria dio del color café rojizo esperable, y 

presenta un brillo apreciable y característico de la cubierta del fruto. Si bien se puede 

notar la variabilidad en las características físicas y por consecuente químicas del piñón 

varían del momento de su recolección, año de cosecha, lugar periodo y estado de 

madurez y nutricional de la planta que le da sus características, por lo cual, es 

esperable la potencial variabilidad de las características del fruto.(Escobar Álvarez & 

Estévez A, 2008) 
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 Piñón 

Área 
7,81 cm2 

Perímetro 
14,69 cm 

Feret 
5,95 cm 

Circularidad 
0,451 

Solidez 
0,966 

Relación de Aspecto (AR) 
3,39 

Color 

 
 

L* 44 

a* 9 

b* 23 

 

8.4.1.2. Análisis de textura y fractal 

Los valores de la dimensión fractal superficial (DFsup), oscilan entre 2 y 3 hace relación 

con la rugosidad de la superficie (Baima & Ribotta, 2019), para los piñones analizados 

presentan una dimensión fractal promedio de 2,090 ± 0,036, considerándola una 

superficie bastante lisa y homogénea según la escala de grises. 

Figura 56. Descripción de la morfología de piñón obtenido usando el Analizador 

de Partículas Extendido y Color promedio. 
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DFsup=2,090 ± 0,036 

 

El análisis de textura mostro ser una herramienta efectiva para cuantificar la semilla de 

piñón, esta técnica se ha utilizado en otras estructuras de alimentos como películas 

comestibles o trozos de alimentos(Arzate Vázquez, 2011; Baima & Ribotta, 2019). La 

tabla 6 presenta los valores del análisis de textura y contorno del piñón por medio del 

análisis de coocurrencia de escala de grises y de contorno por fractales.  

 

Tabla 6. Valores de los parámetros de textura y contorno de piñón. 

 
Energía  

(x 10-3) 
Contraste Homogeneidad Entropía DFcont 

Piñón 7,89 ± 4,06 1,96 ± 1,22 0,64 ± 0,08 5,49 ± 0,41 1,92 ± 0,01 

Los valores representan X±SD 

 

Como era de esperarse, las características de textura son concordantes con el análisis 

de fractales superficial. La energía, medida de la homogeneidad local de la imagen, 

mostró una mayor desviación de los valores de uniformidad entre los piñones, 

demostrando que algunos de los elementos analizados mostraban más textura que 

Figura 57. Topografía superficial 3D de piñón y su correspondiente valor de 

DFsup 
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otros. En el caso de contraste demostró una gran desviación entre las muestras 

analizadas, y la homogeneidad demostró una estructura homogénea entre sí, pero que 

presenta líneas o rugosidades intermitentes. La entropía, variable relacionada con el 

orden o desorden de la imagen y se relaciona con la textura de la imagen, demostró 

que si bien es una estructura homogénea y de baja rugosidad, presenta una textura 

compleja entre sí, demostrando las elevaciones superficiales que demuestran las 

semillas. 

Para el caso de la dimensión fractal de contorno (DFcont), permite determinar cuan 

irregular es el contorno del piñón y al igual que los valores obtenidos por el análisis 

morfométrico, presento características de una homogeneidad en su contorno. 

 

8.4.2. Análisis de arándano 

8.4.2.1. Análisis morfométrico y color 

Los valores promedio del análisis morfométrico y color para las muestras de arándanos 

se visualizan en la figura 56. Se obtuvieron medidas acordes con la normal de calidad 

de arándano fresco de exportación para los arándanos analizados(Comité de 

Arándano de Chile & Asociación de Exportadores de Frutas de Chile (Asoex), 2013), 

obteniendo el largo mayor a 1,2 cm áreas acorde al diámetro del arándano, todo el 

color del fruto fue del color característico azulino, sin presencia superficie del fruto en 

color verde o roja, sin daño superficial del fruto y sin deshidratación o falta de turgencia 

aparente. 

La circularidad de los frutos fue entre las 0,7 a 0,8 unidades, lo cual nos da una 

circularidad media acorde con la forma semicircular del fruto, presentando una 

apariencia en el arándano 2 y 3 ligeramente menos circular que el arándano 1. Se 

demuestra que el arándano presentó una solidez de aproximadamente 0,799 - 0,850 

es una estructura menos lisa y convexa que el piñón, pero sin presentar mayores 

imperfecciones en su contorno. Con respecto a la relación de aspecto de los frutos 

observamos que la relación es casi 1:1, lo cual es concordante con su estructura 
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semicircular y demostrado la estructura ligeramente más alargada en su largo para 

este fruto. 

 Arándano 1 Arándano 2 Arándano 3 

Área 
1,52 cm2 1,46 cm2 1,24 cm2 

Perímetro 
4,94 cm 4,93 cm 4,67 cm 

Feret 
1,55 cm 1,52 cm 1,37 cm 

Circularidad 
0,781 0.754 0,717 

Solidez 
0,804 0,799 0,850 

Relación de 

Aspecto (AR) 1,232 1,226 1,148 

Color 

 
   

L* 41 30 33 

a* 0 0 0 

b* 7 -8 -8 

 

Se puede identificar que a pesar de la ligera diferencia en a la forma de los arándanos 

y en el color de ellos, no existen diferencias significativas (p < 0,05) para ninguno de 

los parámetros analizados. 

 

 

Figura 58. Descripción de la morfología de arándano obtenido usando el 

Analizador de Partículas Extendido y Color promedio. 
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8.4.2.2. Análisis de textura y fractal 

La dimensión fractal superficial de los arándanos no presentaron diferencias 

significativas entre ellos (p < 0,05), obteniendo valores cercanos 2 demostrando que 

la rugosidad superficial sería bastante lista y homogénea, lo cual es esperable para 

una fruta fresca (no deshidratada) para el caso de los arándanos(Comité de Arándano 

de Chile & Asociación de Exportadores de Frutas de Chile (Asoex), 2013). 

Arándano 1 Arándano 2 Arándano 3 

   

DFsup=1,985± 0,004 DFsup=1,975 ± 0,002 DFsup=1,976 ± 0,005 

 

El análisis de textura mostro ser una herramienta efectiva para cuantificar el arándano 

a pesar de ser tan homogéneo. La tabla 7 presenta los valores del análisis de textura 

y contorno del piñón por medio del análisis de coocurrencia de escala de grises y de 

contorno por fractales. Como se podía observar el contorno fractal de arándano una 

estructura lisa y semi homogénea, sin mayores rugosidades o cambios entre los frutos. 

La textura obtenida para los arándanos, al igual que para piñón, fue concordantes con 

el análisis de fractales superficial. La energía no presento diferencias significativas 

entre las muestras, demostrando la uniformidad y homogeneidad entre los frutos al ser 

de la misma especie y probablemente misma cosecha. Con respecto al contraste y 

homogeneidad, podemos observar que el arándano 1 presenta una mayor coloración 

Figura 59. Topografía superficial 3D de los arándanos y su correspondiente valor 

de DFsup 
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y menor homogeneidad en su estructura, siendo ligeramente más rugosa, pero a pesar 

de ello no se observaron diferencias significativas con las otras dos muestras. 

 

Tabla 7. Valores de los parámetros de textura y contorno de las muestras de arándano. 

Muestra 
Energía 

(x 10-3) 
Contraste Homogeneidad Entropía DFcont 

Arándano 1 3,73 ± 1,35a 7,23 ± 3,17b 0,49 ± 0,05c 6,07± 0,34d 1,84 ± 0,01e 

Arándano 2 4,31 ± 0,48a 3,41 ± 0,73b 0,52 ± 0,03c 5,83 ± 0,09d 1,83 ± 0,01e 

Arándano 3 4,42 ± 1,56a 4,61 ± 2,92b 0,53 ± 0,04c 5,86 ± 0,41d 1,80 ± 0,01e 

Los valores representan X±SD. a-e Letras iguales en la misma columna demuestran que no existen diferencias significativas 

(p < 0,05) entre las muestras para el mismo parámetro. 

 

Se aprecia que la entropía entre las muestras no presentó diferencias significativas 

entre sí, y presentó una mayor entropía que el piñón en el caso del arándano a pesar 

de ser un fruto más circular, más liso, más uniforme entre sí. Considerando que la 

textura fue analizada con la coocurrencia de grises de la imagen, los valores más 

elevados de entropía pueden ser atribuidos al color del fruto, que, si bien es un color 

morado-azulino semi uniforme, presenta pequeñas diferencias de coloración en su 

epidermis con “manchas” de colores más morados o más blancos y brillantes dentro 

de estas, capacidad que el piñón demuestra con una mayor diferencia de color entre 

el color central y final de la semilla, y al realizarse un análisis en el centro del fruto 

presentaría el piñón una mayor homogeneidad y menor entropía. 

Considerando lo anterior, se recomienda el uso de estas herramientas para la 

caracterización de alimentos, demostrando su gran utilidad en superficies biológicas, 

como monitor de cambios estructurales y la posibilidad de caracterización estructural 

de superficies.(Arzate Vázquez, 2011; Baima & Ribotta, 2019; Yonis et al., 2020) 
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9. CONCLUSIÓN 

ImageJ es una gran herramienta que ha evolucionado junto a la era digital, permitiendo 

analizar y procesar imágenes de ámbito científico, produciendo una base en los 

softwares computaciones al poseer uno de acceso libre, aceptabilidad en todos los 

sistemas operativos, de fácil comprensión, alta reproducibilidad y capacidad de mejora 

continua. Considerando lo anterior, si se pudo comprobar que el software ImageJ es 

una herramienta actual para el análisis digital de imágenes, generando hasta la fecha 

artículos científicos utilizando la herramienta o sus derivados, y que abre la posibilidad 

en el uso de las ciencias de los alimentos al ser una categoría emergente para su 

aplicación y existiendo todo el campo de reconocimiento y calidad de los alimentos por 

explorar. 

Se pudo validar la aplicación, manejo y desempeño del software por medio de los 

ejemplos controlados y no estandarizados del semillas y frutos. Obteniendo resultados 

que señalan la importancia del manejo del posicionamiento del fruto, contraste de 

fondo e iluminación en la captura de la imagen. Por medio del análisis de imágenes de 

UFC y emulsiones, se pudo apreciar la efectividad de la reproductividad de los análisis 

de imágenes por medio de la herramienta, obteniendo resultados similares a los 

calculados en los artículos y demostrando una correlación lineal entre los análisis de 

UFC realizados de manera manual y los predichos por el programa.  

Se consiguió valorar el “Instructivo de uso de ImageJ”, permitiendo demostrar que la 

buena aplicación y manejo del instructivo es posible, logrando desarrollar de manera 

efectiva el análisis de color, recuento de UFC y recuento automático de semillas. Así 

mismo se logró entregar una buena apreciación de lo bien ilustrado y didáctico que es 

y se entregaron herramientas de mejoras para el mismo que fueron bien 

implementadas. Está a consideración apreciar que es necesario dedicaría un tiempo 

de utilización del programa para lograr aplicar de manera correcta todas las 

herramientas disponibles por medio del software.  

Se demostró las aplicaciones del software sobre alimentos chilenos, caracterizando 

sus características morfométricas, color y textura por escala de coocurrencia de grises 

y dimensión fractal sin mayores dificultades, demostrando la efectividad de estas 
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aplicaciones utilizando una estructura uniforme-esférica y otra uniforme-corniforme y 

caracterizando correctamente las características esperadas. Por lo cual, sí es posible 

implementar el uso de ImageJ como herramienta en el ámbito de las Ciencias y 

Tecnologías de los Alimentos. 
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11. ANEXO 

Anexo 1. Imágenes originales de microscopia de emulsiones y diferencia del 

tamaño de las emulsiones 
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Anexo 2. Imágenes originales de UFC 
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Anexo 3. Paso a paso del procesamiento de análisis de semillas  
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Anexo 4. Paso a paso del proceso de medición de tamaño  
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Anexo 5. Paso a paso del proceso de análisis de color en ImageJ 
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Anexo 6. Paso a paso del proceso de análisis de color en Photoshop 
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Anexo 7. Paso a paso del proceso de análisis de emulsiones 
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Anexo 8. Paso a paso del proceso de recuento de ufc en ImageJ 
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Anexo 9. Paso a paso de Textura (GLCM) 
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Anexo 10. Paso a paso de la comparación de análisis fractal superficial 
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Anexo 11. Paso a paso del análisis fractal contorno 

 
 

 

 

 

 

 


